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About This Book and the Library

The User Guide for Analysis Center provides conceptual information about the NetIQ 
Analysis Center product (Analysis Center), an overview of Analysis Center components, 
information about installing and managing Analysis Center, and instructions for 
configuring reports.

Intended Audience
This book provides information for individuals responsible for understanding Analysis 
Center concepts, and for system administrators and users responsible for installing, 
configuring, and reporting with Analysis Center. 

Other Information in the Library
The library provides the following information resources:

Analysis Center for AppManager Management Guide 
Provides conceptual information about Analysis Center. This book is intended 
for system administrators and users responsible for configuring and using 
Analysis Center, for reporting on AppManager data. This book also provides an 
overview of the Analysis Center user interfaces and the Help.

Help 
Provides context-sensitive information and step-by-step guidance for common 
tasks, as well as definitions for each field on each window.
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Conventions

The library uses consistent conventions to help you identify items throughout the 
documentation. The following table summarizes these conventions.

Convention Use

Bold • Window and menu items
• Technical terms, when introduced

Italics • Book and CD-ROM titles
• Variable names and values
• Emphasized words

Fixed Font • File and folder names
• Commands and code examples
• Text you must type
• Text (output) displayed in the command-line 

interface

Brackets, such as 
[value]

• Optional parameters of a command

Braces, such as {value} • Required parameters of a command

Logical OR, such as
value1 | value2

• Exclusive parameters. Choose one parameter.
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About NetIQ Corporation

NetIQ Corporation, an Attachmate business, is a leading provider of comprehensive 
systems and security management solutions that help enterprises maximize IT service 
delivery and efficiency. With more than 12,000 customers worldwide, NetIQ solutions 
yield measurable business value and results that dynamic organizations demand. Best-of-
breed solutions from NetIQ Corporation help IT organizations deliver critical business 
services, mitigate operational risk, and document policy compliance. The company’s 
portfolio of award-winning management solutions includes IT Process Automation, 
Systems Management, Security Management, Configuration Control and Enterprise 
Administration. For more information, please visit www.netiq.com

Contacting NetIQ Corporation
Please contact us with your questions and comments. We look forward to hearing from 
you.

Sales Email: info@netiq.com

Telephone: 1-713-418-5555 (United States) 
+353 (0) 91-782-677 (Europe, Middle East, and Africa)
For other locations, see our Support Contact Information Web 
site at www.netiq.com/support

Support Web Site: www.netiq.com/support
About NetIQ Corporation     xiii
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Chapter 1

Introducing Analysis Center

Analysis Center imports raw data from multiple sources such as AppManager 
repositories, transforms the data into useful information about the computing 
infrastructure that supports your business, and publishes that information in graphical 
or tabular reports. You can use these reports to:

• Track performance. Are my Web servers operating within the limits of current 
system resources? Is there any degradation of throughput on my network?

• Uncover trends. Is there an increase in the number of HTTP requests handled by 
my Web servers? Is there an increase in the number and size of messages conveyed 
by my Exchange Servers?

• Correlate events. Does the volume of customer traffic during the holiday shopping 
season overwhelm the memory and CPU of my Web servers? Does an increase in 
the number and size of messages conveyed by my Exchange Servers have a negative 
impact on network performance?

• Make forecasts. At what point will customer traffic outpace the system resources on 
my Web servers and when should I upgrade? At what point will the increase in size 
and number of messages conveyed by my Exchange Servers have a degrading effect 
on network throughput and when should I upgrade?

• Track security events. Has there been an unusual number of failed login attempts? 
Are my Web servers subject to frequent port scanning?
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Analysis Center is built around Microsoft SQL Server, SQL Server Analysis Services, 
and SQL Server Reporting Services. Employing these technologies facilitate the transfer 
and manipulation of large amounts of data. It also ensures rapid retrieval of 
information, and provides reports of up-to-the minute analyses of your enterprise.

Analysis Center Architecture
Analysis Center includes a number of software components that you can install on one 
computer or distribute across multiple computers. The following models illustrate the 
Analysis Center architecture, and the Analysis Center with Appmanager architecture, 
with software components installed on separate computers. 
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The source databases (AppManager repositories) copy the data to the Data Marts, and 
from the Data Marts to the Data Warehouse. The Analysis Center Console enables you 
to perform queries on the Data Warehouse using the OLAP server and the Analysis 
Center Warehouse. The Web Service connects to the Data Warehouse, OLAP, and 
configuration databases on behalf of the Console in order to enable users to perform 
Analysis Center administrative functions, configure and run reports. The Web Part and 
Data Extension make the same connections with the Web Service to publish, print, and 
provide Web access to reports via SQL Reporting Services and Microsoft SharePoint.
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Analysis Center Components
This section describes the components of Analysis Center.

Data Mart
A Data Mart is a SQL Server database that Analysis Center creates for each 
AppManager data source. A Data Mart collects and processes data from data sources, 
and then stores it in fact and dimension tables to be used by the Data Warehouse. A 
Data Mart serves several purposes:

• Stores the data copied from the source databases for processing.

• Stored procedures process the copied data.

• Fact and dimension tables store the processed data.

• The fact tables function as a component of the Data Warehouse.

The SQL Server agent copies the data from the Data Source to the Data Mart, and 
thereafter to the Data Warehouse, by using SQL Server Integration Services (SSIS) 
packages.

Data Warehouse
The Data Warehouse is made up of two relational databases and a multidimensional 
database. The AC_Warehouse and AC_OLAP databases are used for AppManager 
reporting. 

The relational database AC_Configuration supports administrative functions 
implemented from the Analysis Center Console. The information in the Configuration 
database includes:

• Analysis Center security information, such as the level of privileges for each 
Analysis Center role and which users are assigned to which roles.

• Connection information: the SQL server and database names used during the 
generation of AppManager reports.
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• The status of the SSIS packages that are responsible for copying data from one 
database to another.

• The status of scheduled reports.

• Custom schedule configuration.

The relational database AC_Warehouse serves as the immediate source of data for the 
multidimensional database. The relational database is managed by Microsoft SQL 
Server, and contains, among other things, the dimensional data copied from the Data 
Marts and views linked to the fact tables in the Data Marts.

The multidimensional database AC_OLAP is managed by Microsoft SQL Server Analysis 
Services, and contains aggregations (for example, maximum, minimum, average) of the 
data copied from the source databases. These aggregated values are stored in cubes 
designed to facilitate the rapid query of large amounts of data.

Each Data Mart contains the following cubes:

•  Data organized by the local time on the AppManager computer

•  Data organized by the UTC time (Greenwich Mean Time).

A cube is a structure for data that uses hierarchical dimensions as an organizing 
principle. Dimensions describe data from a particular point of view (for example, the 
computer and application from which it was generated, or the date and time during 
which it was generated). The hierarchical structure of dimensions allows you to select 
data from any point in the hierarchy (for example, all data generated during 2005; all 
data generated during December 2005; or all data generated December 1, 2005). Given 
this structure and organization of aggregate values, you can, for example, create reports 
for:

• The average, minimum, and maximum use of memory resources by all Exchange 
Servers for the year 2005.

• The average growth rate for all SQL Server databases for the month of December, 
2005.

• The average daily use of CPU for all Domino servers for 2004 and 2005.
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Web Service
The Analysis Center Web Service authenticates Console, Data Extensions, and Web 
Part connections established during report generation and runs the SQL queries that 
gather report data. 

SQL Reporting Services and Data Extension
SQL Reporting Services is a Microsoft addition to SQL Server that facilitates the 
creation, management, and delivery of reports. The Data Extension is a NetIQ addition 
that allows Analysis Center reports to be displayed within SQL Reporting Services.

Web Part
If you use Microsoft SharePoint technology, the Web Part extends Analysis Center 
reports to SharePoint Web sites.

Console
The Console is the Analysis Center user interface, from which you perform 
administrative functions and generate reports. For more information, see “Installing 
Analysis Center” on page 41. The Analysis Center administrative functions include:

• Defining Analysis Center users, groups, and permissions sets.

• For AppManager repositories, setting the schedules for how often data is copied to 
the Analysis Center Data Warehouse and reconciling resource identities so each 
computer in an enterprise has a single identity.

You run reports from the Console by setting the report context, and then viewing the 
results. The context controls for a report let you:

• Select the data streams and computers

• Specify the time frame

• Select which measures of the data you want for your report (for example, average, 
minimum, maximum)
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Chapter 2

Planning the Installation

Before you install Analysis Center, there are a number of decisions you need to make:

• How many computers and SQL Servers do you want to use for Analysis Center 
components (interface, databases, related services)?

• Which types of logon accounts do you want to use for the various SQL Server 
services (Windows or local system)?

• Which type of authentication do you want to use for each SQL Server (Windows or 
Mixed Mode), and how you want to connect between the various SQL Servers 
(Windows or SQL Server authentication)?

• Will you use Report Designer, which is a component of Microsoft SQL Server 2005 
Reporting Services Service Pack 2, to customize Analysis Center reports?

• Will you use Microsoft Windows SharePoint Services to display reports on the 
Analysis Center Web Part?
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Companion Analysis Center Utilities
The Utilities folder of the Analysis Center installation kit includes the following 
utilities.

Utility Description

ACPreCheckUtility -- Data 
Source Verification and 
Size Estimation

The Data Source Verification and Size Estimation 
utility helps you estimate the sizes needed for the 
Analysis Center databases and diskspace. Consider 
running this utility before installing Analysis Center.

LegendVerificationUtility -- 
AM Legend Verification

AM Legend Verification screens the existing legends 
defined in your AppManager database and identifies 
any legends that Analysis Center may not be able to 
resolve.
You can run this utility only if you have installed the 
Analysis Center Data Warehouse on your server. The 
utility asks for your Analysis Center Data Warehouse 
login information, and then makes a connection to the 
Data Warehouse database in order to perform the 
legend processing that is available only through 
Analysis Center.
The utility also needs to make a connection to your 
AppManager database in order to read the existing 
legends stored in the AppManager database. For 
more information about how to use this utility, see the 
utility help.

NetIQ AC Diag Tool If you report problems to NetIQ Technical Support, 
you might be asked to start this utility, which gathers 
data used to diagnose and solve problems.
8     Analysis Center User Guide



Distributing Analysis Center Components
The Analysis Center components (Data Warehouse, SQL Reporting Services Data 
Extension, Web Part, Web Service, and Console) can be installed together on a single 
computer, installed in any combination on separate computers, or installed individually 
on separate computers. Your decisions about how to distribute these components 
should be guided by the volume of data that will be moving from one database to 
another, the frequency at which data will be processed, the number and frequency of 
reports that will run against the data, and the amount of data covered in reports.

In general, you can anticipate the following:

• Console: demands significant memory and CPU resources for presenting reports.

• Data Mart database: each Data Mart requires disk space at least equal to the disk 
space used by its source of data; demands significant memory and CPU resources 
for processing data.

• Data Warehouse relational database: requires minimal disk space; requires reliable 
network support to accommodate the volume of data traffic; demands moderate to 
significant memory and CPU resources to process data.

• Data Warehouse multidimensional database: requires minimal disk space; 
demands significant memory and CPU resources to process cubes and queries.

• Web Service: at least 512 MB RAM; requires minimal disk and CPU resources.

• Web Part: requires Microsoft Windows SharePoint Services and therefore 
additional system requirements. For more information, see “Web Part for Windows 
SharePoint Services” on page 35.

For more information, see “System Requirements” on page 23.
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Deciding Between Windows and SQL 
Authentication

When you install the Analysis Center Data Warehouse and Web Service, you need to 
configure the type of authentication used for a number of different connections 
between Analysis Center components.

During the Data Warehouse installation, the connections that you need to configure 
are:

• Data Warehouse SQL Server agent to Data Warehouse SQL Server

• Data Warehouse SQL Server agent to Data Warehouse Analysis Services

• Data Warehouse Analysis Services to Data Warehouse SQL Server

• Data Mart SQL Server agent to Data Mart SQL Server

• Data Mart SQL Server agent to Data Warehouse SQL Server

During the Web Service installation, those connections are:

• Web Service to Data Warehouse SQL Server

• Web Service to Data Warehouse Analysis Server

With the exception of the Data Warehouse SQL Server Agent to Data Warehouse 
Analysis Services and Web Service to Data Warehouse Analysis Server connections, 
which must use Windows Authentication, all the others can use either Windows or 
SQL Server Authentication. Before you install Analysis Center, you will need to make 
some decisions about the type of authentication you want to use in each case, set up the 
necessary accounts and permissions, configure each SQL Server to use the appropriate 
type of authentication, and configure your SQL Server services to use the appropriate 
accounts. For more information, see “SQL Server Services” on page 15.
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To use Windows Authentication:

1. Configure each Windows account as a login for each SQL Server to which that 
account needs access.

2. Add each login to the appropriate Server Role for each SQL Server.

3. Configure each SQL Server to use Windows Authentication Mode or Mixed Mode.

To use SQL Server Authentication:

1. Create the same login name and password on each SQL Server to which you will 
connect using that account (the login name and password have to exist locally on 
each server).

2. Add each login to the appropriate Server Role for that SQL Server.

3. Configure each SQL Server to use Mixed Mode Authentication.

During installation of the Data Warehouse, you select one of three options for the types 
of authentication you want to use for connections between the Data Warehouse and 
any Data Mart SQL Servers. For more information, see “Installing the Data 
Warehouse” on page 44. 

The options are:

• Default (Recommended)

• Windows-Only

• Custom
Chapter 2 • Planning the Installation     11



Default (Recommended)
This option is recommended for a fully distributed environment.

Under the Default option, the Data Warehouse SQL Server Agent and Analysis 
Services use Windows Authentication to connect to the Data Warehouse. In this case, 
the logon account for each service is used to make the connection. The SQL Server 
Agent logon account must have administrative permissions for the Data Warehouse 
SQL Server and Analysis Server (System Administrators server role for the SQL Server). 
If you do not initially configure the SQL Server Agent account with administrative 
permissions, you can do so later in the installation.

Under the Default option, Data Mart SQL Server Agents use SQL Server 
Authentication to connect to the Data Mart and Data Warehouse SQL Servers. In this 
case, the installation program creates the necessary SQL Server logins and encrypts the 
passwords.

For this option, the Data Warehouse and Data Mart SQL Servers have to be configured 
to use Mixed Mode (Windows and SQL Server Authentication).
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Windows-Only
This option is not recommended for a fully distributed environment.

Under the Windows-only option, use Windows Authentication for all connections. The 
logon account for each service is used to make the connection.

• The Data Warehouse SQL Server and SQL Server Agent, Analysis Services, any 
Data Mart SQL Servers and SQL Server Agents, and the Analysis Center Web 
Service must all use the same domain account for their service log-on accounts. The 
domain account used for these services must have administrative permissions for 
the Data Warehouse SQL Server, any Data Mart SQL Server, and the Analysis 
Server (System Administrators server role for the SQL Servers). Administrative 
permissions for Data Mart SQL Servers must be granted prior to installation. Other 
administrative permissions can be granted during installation. The domain account 
must be trusted for delegation.

• All SQL Server services must have a Service Principle Name.

• MS OLAPService(Analysis Services) must have a Service Principle Name.

• For the Windows-only option, the Data Warehouse and Data Mart SQL Servers 
can be configured to use either Windows Authentication Mode or Mixed Mode.

• All Analysis Center SQL Servers and the Analysis Server must be added to the 
Active Directory of their domain.

• Any domains that host Analysis Center computers must be configured for Kerberos 
security.

• On any computer hosting an Analysis Center SQL Server, Microsoft Distributed 
Transaction Coordinator (DTC) must be configured for network access.

• All computers hosting Analysis Center components must be trusted for delegation.
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The barrier to using Windows authentication for all the connections in a fully 
distributed environment is the double-hop issue. The problem, briefly, is that the 
security credentials used to make the connection from Computer A to Computer B 
cannot be used to make a necessary subsequent connection from Computer B to 
Computer C, and so the operation fails. For example, to carry out the OLAP Processing 
job, the Analysis Server (on Computer A) makes a connection to the Data Warehouse 
SQL Server (on Computer B) to get dimension data, and makes a subsequent 
connection from the Data Warehouse SQL Server (on Computer B) to the Data Mart 
SQL Server (on Computer C) is required to get fact data. The credentials of the Analysis 
Services logon account are not successfully passed from Computer A to Computer B to 
Computer C.

If you want to use Windows authentication for every connection between Analysis 
Center components, you have to install the Data Warehouse SQL Server, Analysis 
Services, the Web Service, and any Data Mart SQL Servers on the same computer.

Custom
With the Custom option, you can, if you want, use a different type of authentication for 
each connection.

If you use Windows Authentication, the SQL Server Agent logon account must have 
administrative permissions for the Data Warehouse SQL Server and Analysis Server 
(System Administrators server role for the SQL Server). If you do not initially configure 
the SQL Server Agent account with administrative permissions, you can do so later in 
the installation. In addition, the logon account for any Data Mart SQL Server Agent 
must be configured as a member of the System Administrators server role for the Data 
Warehouse SQL Server and for each Data Mart SQL Server before you install Analysis 
Center.

If you use SQL Server Authentication for a connection, the login name and password 
you specify for that connection must already be configured on the relevant SQL Server 
and must also belong to the System Administrators server role for that SQL Server.

Under the Custom option, Analysis Center does not perform any management of the 
SQL Server accounts and passwords. Passwords are sent in clear text, which may pose 
some security risks.
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Any SQL Server to which you connect using SQL Server Authentication must be 
configured to use Mixed Mode (Windows and SQL Server Authentication).

Account Requirements
This section describes the account requirements for installing Analysis Center and for 
the SQL Server services that support Analysis Center.

Analysis Center Installation
To install Analysis Center, you need to have administrative access to the computer on 
which you are installing components. You can use either a domain or local 
administrator account.

During installation of the Data Warehouse, you are asked whether you want to use 
Windows or SQL Authentication to connect to that SQL Server. If you use Windows 
Authentication, the account under which you are running the installation must belong 
to the System Administrators group for the SQL Server. If you use SQL Authentication, 
you must specify a SQL Server account that belongs to the System Administrators group 
for the SQL Server. 

You cannot use a SQL Server account whose username contains spaces, single, or 
double quotes. You cannot use a SQL Server account whose password contains spaces 
or ampersand character. However, you can use a SQL Server account whose password 
contains single or double quotes.

The multidimensional database can be installed on the local computer or on a remote 
computer.

SQL Server Services
This section discusses the permissions required for the various SQL Server service logon 
accounts under different distribution scenarios. Each example assumes one instance of 
SQL Server or Analysis Services on a computer. 
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If you distribute components across different instances of SQL Server on the same 
computer, the same requirements for permissions apply server to server (for example, 
from the Data Mart SQL Server to the Data Warehouse SQL Server).

Source Database and Analysis Center Databases on One Computer
Source database and Analysis Center computer (SQL Server and Analysis Server):

Authentication Mode Required Permissions

Windows-Only 
Authentication 

SQLSERVER
• Member of System Administrators server role 

for the SQL Server
SQLSERVERAGENT

• Member of System Administrators server role 
for the SQL Server

MS OLAPService
• Member of System Administrators server role 

for the SQL Server
Note
All services must use the same domain account.

SQL Server and Windows 
Authentication

SQLSERVER can run as Local System.
SQLSERVERAGENT and MS OLAPService must 
have permissions described above.
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Source Database on First Computer; All Analysis Center Databases 
on Second Computer
Analysis Center computer (SQL Server and Analysis Server):

Authentication Mode Required permissions

Windows-Only 
Authentication 

SQLSERVER
• Member of System Administrators server role 

for the SQL Server
• db_datareader database role for the source 

database
SQLSERVERAGENT

• Member of System Administrators server role 
for the SQL Server

• db_datareader database role for the source 
database

MS OLAPService
• Member of System Administrators server role 

for the SQL Server
Note
All services must use the same domain account.

SQL Server and Windows 
Authentication

SQLSERVER can run as Local System.
SQLSERVERAGENT and MS OLAPService must 
have permissions described above.
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Source Database on First Computer, Data Mart on Second Computer, 
Data Warehouse on Third Computer
Data Mart computer (SQL Server):

Authentication Mode Required Permissions

Windows-Only 
Authentication 

SQLSERVER
No special requirements
SQLSERVERAGENT

• Member of System Administrators server role 
for the Data Mart SQL Server

• Member of System Administrators server role 
for the Data Warehouse SQL Server

• db_datareader database role for the source 
database

SQL Server and Windows 
Authentication

SQLSERVER can run as Local System.
SQLSERVERAGENT must have permissions 
described above.
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Data Warehouse computer (SQL Server and Analysis Server):

Authentication Mode Required Permissions

Windows-Only 
Authentication 

SQLSERVER
• Member of System Administrators server role for 

the Data Warehouse SQL Server
• db_datareader database role for the source 

database
SQLSERVERAGENT

• Member of System Administrators server role for 
the Data Warehouse SQL Server

• Member of System Administrators server role for 
the Data Mart SQL Server

• db_datareader database role for the source 
database

MS OLAPService
• Member of System Administrators server role for 

the Data Warehouse SQL Server
Note
All services must use the same domain account.

SQL Server and 
Windows Authentication

SQLSERVER can run as Local System.
SQLSERVERAGENT and MS OLAPService must use 
Windows authentication and have permissions 
described above.
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Source Database and Each Analysis Center Database on a Separate 
Computer
Data Mart computer (SQL Server):

Authentication Mode Required Permissions

Windows-Only 
Authentication 

SQLSERVER
No special requirements
SQLSERVERAGENT

• Member of System Administrators server role 
for the Data Mart SQL Server

• Member of System Administrators server role 
for the Data Warehouse SQL Server

• db_datareader database role for the source 
database

SQL Server and Windows 
Authentication

SQLSERVER can run as Local System.
SQLSERVERAGENT must have permissions 
described above.
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Data Warehouse relational database computer (SQL Server):

Data Warehouse multidimensional database computer (Analysis Server):

Authentication Mode Required Permissions

Windows-Only 
Authentication 

SQLSERVER
• Member of System Administrators server role for 

the Data Warehouse SQL Server
• Member of System Administrators server role for 

the Data Mart SQL Server
• db_datareader database role for the source 

database
SQLSERVERAGENT

• Member of System Administrators server role for 
the Data Warehouse SQL Server

• Member of System Administrators server role for 
the Data Mart SQL Server

• db_datareader database role for the source 
database

Note
All services must use the same domain account.

SQL Server and 
Windows Authentication

SQLSERVER and SQLSERVERAGENT must have the 
permissions specified above.

Authentication Mode Required Permissions

Windows-Only 
Authentication 

MS OLAPService
• Member of System Administrators server role for 

the Data Warehouse SQL Server
• Member of System Administrators server role for 

the Data Mart SQL Server

SQL Server and 
Windows Authentication

MS OLAPService must have the permissions specified 
above.
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Analysis Center Web Service
The Web Service uses impersonation to make connections from the Analysis Center 
Console and Data Extension to the Analysis Center Data Warehouse, and through a 
linked server definition, to the Data Mart. Impersonation involves using a single 
account to make connections to various Analysis Center components regardless of 
which account is used to start the Console. The permissions required of the Web 
Service impersonation account are described below:

• The account must belong to the Administrators group on each computer to which 
it makes a connection. If you are using replicated accounts for different domains, 
the account can be a local account. Otherwise, it must be a domain account.

• Connections to the Data Warehouse SQL Server can use either Windows or SQL 
Server Authentication. In either case, the account must belong to the System 
Administrators role for the Warehouse SQL Server.

• Connections to the Data Warehouse Analysis Server must use Windows 
Authentication. 

• Connections to a Data Mart SQL Server can use either Windows or SQL Server 
Authentication. In either case, the account must belong to the System 
Administrators role for each Data Mart SQL Server.

Connection to Data Mart Database
During the creation of a Data Source, you are asked to specify whether the Data 
Warehouse SQL Server Agent connects to the Data Mart database using Windows or 
SQL Server authentication. If you use SQL Server authentication, the login name you 
specify must be a System Administrator for the Data Mart SQL Server. For more 
information, see the NetIQ Analysis Center for AppManager Management Guide.

Note
If you create a new domain account for use by the Web Service, you need to restart the 
IIS Admin Service in order for Internet Information Services to be aware of the 
account.
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System Requirements
Analysis Center 2.7 components are supported on 32-bit and 64-bit versions of 
Windows Server 2003 with Microsoft SQL Server 2005 Service Pack 2. You can install 
each Analysis Center component on a separate computer. If you install multiple 
components on the same computer, they must meet the system requirements.

The following table identifies the Analysis Center components supported on x86 
(which is a 32-bit architecture), and x64 (which is a 64-bit extended architecture) 
platforms.

Component x86 x64

Console Yes Wow64

Web Service Yes Yes

Data Warehouse Yes Yes

Data Extension Yes Yes

Web Part Yes No
Chapter 2 • Planning the Installation     23



Note
• Wow 64 refers to a 32-bit application emulated on Windows 64-bit platform.

• If you distribute Analysis Center components across multiple computers, you must 
enable the Remote Registry Service on the computers. Otherwise, the installation 
fails.

• If you are using Analysis Center with only one AppManager data source, either the 
Standard or the Enterprise Edition of SQL Server 2005 Analysis Services Service 
Pack 2 is supported. If you are using two or more AppManager data sources with 
Analysis Center, SQL Server 2005 Analysis Services Enterprise Edition Service 
Pack 2 is required.

• If you are reporting on data generated from AppManager version 6.5 UNIX agents, 
Analysis Center requires that you apply hotfix 51991 for Sun Solaris, HP-UX or 
Linux, or AppManager for UNIX 6.5 for AIX Service Pack 1 for IBM AIX. If you do 
not apply the hotfix, the Analysis Center reports display incorrect or missing UNIX 
data. For more information about obtaining the hotfix, contact NetIQ Technical 
Support.
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Hardware and Software Requirements for Analysis Center 
Components

The following tables identify the hardware and software requirements on x86 and x64 
platforms, for each component of Analysis Center. 

Console Computer

Console System Requirements

x86 x64

Screen 
Resolution

1024x768 or higher. 1024x768 or higher.

Processor 600-megahertz (MHz) 
Pentium III-compatible or 
faster processor; 1-gigahertz 
(GHz) or faster processor 
recommended

1-GHz AMD Opteron, AMD 
Athlon 64, Intel Xeon with 
Intel EM64T support, Intel 
Pentium IV with EM64T 
support processor or faster

Operating 
System

Windows Vista, Windows XP 
Professional, Windows 2003

Windows Vista, Windows 
XP Professional, Microsoft 
Windows Server 2003 
Standard x64 Edition, 
Enterprise x64 Edition

Memory 512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended 

512 megabytes (MB) of 
RAM or more; 1 gigabyte 
(GB) or more recommended

Hard Disk Approximately 100 MB of 
available hard-disk space for 
the recommended installation

Approximately 100 MB of 
available hard-disk space 
for the recommended 
installation
Chapter 2 • Planning the Installation     25



Other 
Requirements

NET Framework 2.0 
Redistributable 
Package(x86)

NET Framework 2.0 
Redistributable 
Package(x64)

Microsoft Internet Explorer 
6.0 Service Pack 1 or later

Microsoft Internet Explorer 
6.0 Service Pack 1 or later

Note
If you install the Console on a Windows 2003 computer and plan to connect to a 
remote Web Service, set the Internet Explorer Security settings for Internet and Local 
intranet to Low on the computer where you want to install the console.

Console System Requirements

x86 x64
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Data Mart Computer

Data Mart System Requirements

x86 x64

Processor 600-megahertz (MHz) 
Pentium III-compatible or 
faster processor; 1-gigahertz 
(GHz) or faster processor 
recommended

1-GHz AMD Opteron, AMD 
Athlon 64, Intel Xeon with Intel 
EM64T support, Intel Pentium 
IV with EM64T support 
processor or faster

Operating 
System

Windows 2003 Microsoft Windows Server 
2003 Standard x64 Edition, 
Enterprise x64 Edition

Memory 512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended 

512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended

Hard Disk Approximately 350 MB of 
available hard-disk space or 
more depending on the size of 
the AM repositories

Approximately 350 MB of 
available hard-disk space or 
more depending on the size of 
the AM repositories

Other 
Requirements

NET Framework 2.0 
Redistributable Package(x86)

NET Framework 2.0 
Redistributable Package(x64)

Microsoft Internet Explorer 6.0 
Service Pack 1 or later

Microsoft Internet Explorer 6.0 
Service Pack 1 or later

SQL Server 2005 Service 
Pack 2; same language 
version as the Data 
Warehouse SQL Server.

SQL Server 2005 X64(64-bit) 
Enterprise Edition Service 
Pack 2
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SQL Server Integration 
Services 2005 Service Pack 2

SQL Server Integration 
Services 2005 Service Pack 2

Microsoft Distributed 
Transaction Coordinator 
(MSDTC) service

Microsoft Distributed 
Transaction Coordinator 
(MSDTC) service

Note
Successful copying from a Data Mart to the Data Warehouse requires that the language 
editions, collation, sort order, and locale settings match. For example, if the Data 
Warehouse SQL Server is an English language edition and the Data Warehouse 
computer is set to the English locale, then the Data Mart SQL Server must also be an 
English language edition and the Data Mart computer must be set to the English locale.

Data Mart System Requirements

x86 x64
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Data Warehouse Relational Database Computer

Data Warehouse Relational Database System Requirements

x86 x64

Processor 600-megahertz (MHz) 
Pentium III-compatible or 
faster processor; 1-gigahertz 
(GHz) or faster processor 
recommended

1-GHz AMD Opteron, AMD 
Athlon 64, Intel Xeon with Intel 
EM64T support, Intel Pentium 
IV with EM64T support 
processor or faster

Operating 
System

Windows 2003 Microsoft Windows Server 
2003 Standard x64 Edition, 
Enterprise x64 Edition

Memory 512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended 

512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended

Hard Disk Approximately 350 MB of 
available hard-disk space or 
more depending on the 
size of the Data Marts

Approximately 350 MB of 
available hard-disk space or 
more depending on the size 
of the Data Marts

Other 
Requirements

NET Framework 2.0 
Redistributable Package(x86)

NET Framework 2.0 
Redistributable Package(x64)

Microsoft Internet Explorer 
6.0 Service Pack 1 or later

Microsoft Internet Explorer 6.0 
Service Pack 1 or later

Microsoft Distributed 
Transaction Coordinator 
(MSDTC) service

Microsoft Distributed 
Transaction Coordinator 
(MSDTC) service
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SQL Server 2005 Service 
Pack 2; same language 
version as the Data 
Warehouse SQL Server

SQL Server 2005 X64(64-bit) 
Enterprise Edition Service 
Pack 2

Microsoft Visual C++ 2005 
Service Pack 1 
Redistributable Package 
(x86)

Microsoft Visual C++ 2005 
Service Pack 1 
Redistributable Package (x64)

Data Warehouse Relational Database System Requirements

x86 x64
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Data Warehouse Multidimensional Database Computer

Data Warehouse Multi-dimensional Database System Requirements

x86 x64

Processor 600-megahertz (MHz) 
Pentium III-compatible or 
faster processor; 1-gigahertz 
(GHz) or faster processor 
recommended

1-GHz AMD Opteron, AMD 
Athlon 64, Intel Xeon with 
Intel EM64T support, Intel 
Pentium IV with EM64T 
support processor or faster

Operating 
System

Windows 2003 Microsoft Windows Server 
2003 Standard x64 Edition, 
Enterprise x64 Edition

Memory 512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended 

512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended

Hard Disk Approximately 350 MB of 
available hard-disk space, 
depending on the size of the 
Data Warehouse

Approximately 350 MB of 
available hard-disk space, 
depending on the size of the 
Data Warehouse

Other 
Requirements

NET Framework 2.0 
Redistributable 
Package(x86)

NET Framework 2.0 
Redistributable 
Package(x64)

Microsoft Internet Explorer 
6.0 Service Pack 1 or later

Microsoft Internet Explorer 
6.0 Service Pack 1 or later

SQL Server 2005 Analysis 
Services Service Pack 2 

SQL Server 2005 Analysis 
Services Service Pack 2 
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If you install the Data Warehouse multidimensional database on a remote Analysis 
Server, the computer from which you are making the installation must have the Client 
components from the Analysis Services Setup. 

Data Extension Computer

Data Extension 
System 
Requirements

x86 x64

Processor 600-megahertz (MHz) 
Pentium III-compatible or 
faster processor; 1-gigahertz 
(GHz) or faster processor 
recommended

1-GHz AMD Opteron, AMD 
Athlon 64, Intel Xeon with Intel 
EM64T support, Intel Pentium 
IV with EM64T support 
processor or faster

Operating 
System

Windows 2003 Microsoft Windows Server 
2003 Standard x64 Edition, 
Enterprise x64 Edition

Memory 512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended 

512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended

Hard Disk Approximately 350 MB of 
available hard-disk space for 
the recommended 
installation

Approximately 350 MB of 
available hard-disk space for 
the recommended installation
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Other 
Requirements

NET Framework 2.0 
Redistributable 
Package(x86)

NET Framework 2.0 
Redistributable Package(x64)

Microsoft Internet Explorer 
6.0 Service Pack 1 or later

Microsoft Internet Explorer 6.0 
Service Pack 1 or later

SQL Server 2005 Reporting 
Services Service Pack 2

SQL Server 2005 Reporting 
Services Service Pack 2

Data Extension 
System 
Requirements

x86 x64
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Web Service Computer

Web Service System Requirements

x86 x64

Processor 600-megahertz (MHz) 
Pentium III-compatible or 
faster processor; 1-gigahertz 
(GHz) or faster processor 
recommended

1-GHz AMD Opteron, AMD 
Athlon 64, Intel Xeon with 
Intel EM64T support, Intel 
Pentium IV with EM64T 
support processor or faster

Operating 
System

Windows 2003 with Internet 
Information Services 6.0 or 
later, and ASP.NET enabled

Windows 2003 with Internet 
Information Services 6.0 or 
later, and ASP.NET enabled

Memory 512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended 

512 megabytes (MB) of RAM 
or more; 1 gigabyte (GB) or 
more recommended

Hard Disk Approximately 350 MB of 
available hard-disk space for 
the recommended installation

Approximately 350 MB of 
available hard-disk space for 
the recommended installation

Other 
Requirements

NET Framework 2.0 or later 
and ASP.NET enabled

NET Framework 2.0 or later 
and ASP.NET enabled

Microsoft Internet Explorer 6.0 
Service Pack 1 or later

Microsoft Internet Explorer 
6.0 Service Pack 1 or later

Microsoft Internet Information 
Services (IIS) 6.0, and 
ASP.NET 2.0 

Microsoft Internet Information 
Services (IIS) 6.0, and 
ASP.NET 2.0 
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If you create a new domain account for use by the Web Service, you need to restart the 
IIS Admin Service in order for Internet Information Services to be aware of the 
account.

Web Part for Windows SharePoint Services

Web Part for Windows SharePoint Services System Requirements

x86

Processor 600-megahertz (MHz) Pentium III-compatible 
or faster processor; 1-gigahertz (GHz) or faster 
processor recommended

Operating System Operating Systems: Microsoft Windows Server 
2003 Standard Edition, Windows Server 2003 
Enterprise, Windows Server 2003 Datacenter, 
Windows Server 2003 Web Edition, plus the 
latest service pack

Memory 512 megabytes (MB) of RAM or more; 1 
gigabyte (GB) or more recommended 

Hard Disk Approximately 350 MB of available hard-disk 
space for the recommended installation

Other Requirements Windows SharePoint Services 2.0 Service 
Pack 2.0 or later or Office SharePoint Portal 
Server 2003, .NET Framework 2.0 or later and 
ASP.NET 2.0 enabled
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Supported Data Sources
Analysis Center supports data sources from the following NetIQ products:

• AppManager versions 6.0 and later. For more information, see the NetIQ Analysis 
Center for AppManager Management Guide.

Using Named Instances of SQL Server
If you use named instances of SQL Server on different computers for any of the Analysis 
Center databases, you need to ensure that each client of a database can connect to that 
named instance.

Use the SQL Server Client Network Utility to configure connectivity from each client 
computer to each named instance of SQL Server. For example, from the Data 
Warehouse SQL Server computer to the SQL Server instance for the Data Mart.

To configure connectivity:

1. From the client computer, start the Client Network Utility. Click Start > Programs 
> Microsoft SQL Server > Client Network Utility. The Client Network Utility 
dialog box is displayed.

2. On the General tab, enable TCP/IP and set it as the first protocol.

3. Select TCP/IP and click Enable.

4. Click the arrows to move TCP/IP to the top of the Enabled protocols by order list.

Note
Running SharePoint Portal Server 2003 on Windows Server 2003 Web Edition requires 
SQL Server 2005 Service Pack 2 to be installed on a separate computer; for a complete 
set of system requirements, visit SharePoint Portal Server 2003 System Requirements at:

http://www.microsoft.com/office/preview/sharepoint/sysreq.asp.
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5. On the Alias tab, click Add to open the Add Network Library Configuration dialog 
box.

6. In the Server alias field, specify the SQL Server\Instance name to which the client 
will connect. The same name is displayed in the Server name field.

7. In the Network libraries panel, select TCP/IP.

8. In the Connection parameters panel, specify the Port number through which the 
connection to the SQL Server is made.

If you do not know the port number, select Dynamically determine port.

9. Click OK to close the Add Network Library Configuration dialog box.

10. Click OK to close the Client Network Utility dialog box.

Note
It is preferable to specify the port number. The process of dynamically determining 
the port may cause security alerts in circumstances where there is monitoring for 
port attacks. In circumstances where the client and server are separated by a 
firewall, the system administrator will need to know which port to open.
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SQL Server Licensing Considerations
There are a number of different licensing options you can use for your SQL Server 
environment (for example, per CPU, per user, per device). Which option you choose 
should be based on the unique circumstances of your business. The following summary 
of connections to SQL Server components is provided to help you decide which type of 
licensing will suit you best.

This Analysis Center 
Component

Connects to this SQL Server Component

Data Warehouse SQL 
Server Agent

• Each Data Mart SQL Server
• The Data Warehouse SQL Server
• Analysis Services

Analysis Services • The Data Warehouse SQL Server
• Each Data Mart SQL Server

Data Mart SQL Server 
Agent

• The associated source database SQL Server
• The associated Data Mart SQL Server
• The Data Warehouse SQL Server

Web Service • The Data Warehouse SQL Server
• Analysis Services

Data Extension • The database via the Web Service

Console • The database via the Web Service
• Reporting Services

Web Part • The database via the Web Service
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Analysis Center License Monitoring
For AppManager data sources, Analysis Center requires one license for each server 
(Managed Agent) that provides Analysis Center data. A license monitor shows you how 
many licenses are installed at your site and how many AppManager servers are being 
monitored. The number of Analysis Center servers at your site should be less than or 
equal to the number of installed licenses.

If the number of Analysis Center servers at your site exceeds your licenses, when you 
start the Console, Analysis Center displays a warning message but you can still run or 
deploy reports.

Preparing Report Designer to Customize Reports
You can use the Report Designer component of SQL Server 2005 Reporting Services 
Service Pack 2 to customize Analysis Center reports. To use Report Designer, you must 
first install Visual Studio .NET 2005, and then install SQL Reporting Services on that 
computer. You must also then install the Analysis Center Data Extension on that 
computer. For more information, see “Customizing Reports” on page 201.
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Chapter 3

Installing Analysis Center

This chapter provides procedures to install Analysis Center components.

Overview of Analysis Center Installation
The Analysis Center setup program allows you to install the following components:

• Data Warehouse

• Web Service

• Data Extension

• Console

• Web Part

The Analysis Center setup program allows you to install components on the following 
platforms:

• x86 

• x64 

The x64 setup option installs all components on x64 computers except the Console and 
Web Part. For more information about which components are supported on x64, see 
“System Requirements” on page 23.
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You can install these components individually or in any combination. Depending on 
the choices you make, you are presented with a different set of dialog boxes. 

If you are going to install the various components on separate computers, install the 
components in this order:

1. Data Warehouse

2. Web Service

3. Data Extension

4. Console

5. Web Part

Performing the Installation
Log on to the computer on which you want to install Analysis Center using an account 
that is a member of either the local or domain Administrators group. Close all open 
applications and run the setup program from the Analysis Center installation kit. If you 
double-click setup.exe, the product installation preview page opens in your browser.

If you want to install an Analysis Center component on the computer containing the 
installation kit, you can start the installer by selecting the Production Setup tab and 
then clicking Install NetIQ Analysis Center (x86) or Install NetIQ Analysis Center 
(x64). 

If you install Analysis Center components on multiple computers, copy the installation 
kit to a server at your site that the Analysis Center computer can access. You can then 
start the installation kit at each Analysis Center computer from the shared server. For 
example, from \\SWInstaller\ACInstall\setup.exe. 
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Running the Setup Program
This section describes the steps to install Analysis Center.

To install Analysis Center:

1. Log on with an administrator account to the computer where you want to install an 
Analysis Center component.

2. Run Setup.exe in the root folder of the installation kit.

3. On the Setup tab, click the appropriate option as follows:

- To install Analysis Center on an x86 computer, click Begin x86 Setup.

- To install Analysis Center on an x64 computer, click Begin x64 Setup.

4. In the License Agreement window, click Yes to accept the terms of the license 
agreement and proceed with the installation, or click No to exit the setup program.

5. In the Feature Selection window, select the Analysis Center component that you 
want to install on this computer.

6. Complete the setup program by following the instructions. For more information 
about fields on a window, see the Help.

The following sections describe how to install each separate component.

If you are upgrading Analysis Center, see “Upgrading from Analysis Center version 2.6” 
on page 49. For more information about modifying your Analysis Center installation, 
see “” on page 51.

Recording Installation Settings
Before starting the setup program, you can configure the setup program to record the 
installation settings that you specify on the installation dialogs. You can then reinstall 
Analysis Center in batch mode by issuing a single command. 

To turn on recording and create a recording file windows\setup.iss:, start the 
Analysis Center (x86) or Analysis Center (x64) setup program with the -r switch: 
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For example, NetIQAnalysisCenterSetup_x86 -r

In the future, you can reinstall Analysis Center components on this computer, 
bypassing the installation dialog boxes, by issuing this command:

NetIQAnalysisCenterSetup_x86 -s -f1"c:\Windows\setup.iss" -

f2"c:\Windows\logfile.log”

NetIQAnalysisCenterSetup_x86 is located in the analysis_center\setup folder of the 
installation kit.

If the installation kit is stored on a remote server, issue these commands from Start > 
Run. If the installation kit is stored locally on the Analysis Center computer, you can 
open a command prompt.

Installing the Data Warehouse
You can install the Data Warehouse on a local computer or on a remote computer. If 
you install Analysis Center on a SQL Server failover cluster, run the Analysis Center 
Data Warehouse setup on each node of the cluster, beginning with the node where SQL 
Server is in the Active mode. If you install the Data Warehouse on an Analysis Services 
failover cluster, you must use the Remote Analysis Server option.

SQL Server System Administrator permissions are required for installation of the Data 
Warehouse relational database.

If you are going to connect to the SQL Server instance where you are making the 
installation using the Windows account under which you are running the installation, 
that account must have System Administrator permissions for that SQL Server. For 
more information about Data Warehouse, see “Data Warehouse” on page 4.

Note
Do not install more than one Data Warehouse on a single Analysis Server the cube 
processing job fails.
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To install the Data Warehouse:

1. Log on to the computer where you want to install the Data Warehouse with an 
account that has SQL system administrator privileges. For more information, see 
“Running the Setup Program” on page 43.

2. In the Feature Selection dialog box, select Data Warehouse.

3. Click Next.

4. Complete the setup program by following the instructions on the pages. For more 
information about fields, see the Help.

Installing the Analysis Center Web Service
If you install the Data Warehouse and Web Service on computers that are in different 
domains, and if you chose SQL authentication when installing the Web Service, the 
account under which you run the setup program must have Administrator permissions 
on the Data Warehouse computer.

Do not install the Web Service on the following:

• Domain Controller. If you do, you will not be able to log in to Analysis Center.

• Computers where IIS 6.0 has IIS 5.0 isolation mode enabled. If you do, Web Service 
installation will disable that setting and possibly cause some currently installed Web 
applications to malfunction.

For more information about Web Service, see “Web Service” on page 6.

To install the Analysis Center Web Service:

1. Log on to the computer where you want to install the Web Service with an account 
that has SQL system administrator privileges. For more information, see “Running 
the Setup Program” on page 43.

2. In the Feature Selection dialog box, select Analysis Center Web Service.

3. Click Next.

4. Complete the setup program by following the instructions on the pages. For more 
information about fields, see the Help.
Chapter 3 • Installing Analysis Center     45



Installing the Data Extension
If you are going to use Report Designer to customize reports, install the Data Extension 
on the computer where SQL Server Reporting Services is installed. For more 
information about SQL Reporting Services and Data Extension, see “SQL Reporting 
Services and Data Extension” on page 6.

To install the Data Extension:

1. Log on to the computer where you want to install the Data Extension with an 
account that has SQL system administrator privileges. For more information, see 
“Running the Setup Program” on page 43.

2. In the Feature Selection dialog box, select SQL Reporting Services Data 
Extension.

3. Click Next.

4. Complete the setup program by following the instructions on the pages. For more 
information about fields, see the Help.

Installing the Analysis Center Console
Install the Analysis Center Console to generate reports and manage your Analysis 
Center installation. For more information about the Analysis Center Console, see 
“Console” on page 6.

To install the Analysis Center Console:

1. Log on to the computer where you want to install the Console with an account that 
has SQL system administrator privileges. For more information, see “Running the 
Setup Program” on page 43.

2. In the Feature Selection dialog box, select Analysis Center Console.

3. Click Next.

4. Complete the setup program by following the instructions on the pages. For more 
information about fields, see the Help.
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Installing the Web Part
The optional Web Part feature, based on Microsoft SharePoint technology, allows 
SharePoint sites to display Analysis Center reports and templates. Ensure you create a 
SharePoint configuration database and note the database name before you run the 
setup program. The setup program prompts you for this information. For more 
information about creating a SharePoint configuration database, see the SharePoint 
documentation.

If you install the Web Service on a non-default Web site, you will get an error message 
when configuring the Web Part because the Web Part expects to find the Web Service at 
the default site. The solution is to configure the Web Part to look for the Web Service at 
the correct address. For more information, see “If You Install the Web Service On a 
Non-default Web Site” on page 49. 

To install the Web Part component:

1. Log on to the computer where you want to install the Web Part with an account 
that has SQL system administrator privileges. For more information, see “Running 
the Setup Program” on page 43. 

2. If SharePoint Services or SharePoint Portal Server 2003 are installed after the 
Analysis Center Web Service, the Web Part will not function correctly until you 
perform the steps described in “If You Install SharePoint after Analysis Center” 
on page 48.

3. If you install the Web Service on a non-default Web site, you will get an error 
message when configuring the Web Part because the Web Part expects to find the 
Web Service at the default site. 

4. In the Feature Selection dialog box, select Web Part component.

5. Click Next.

6. Complete the setup program by following the instructions on the pages. For more 
information about fields, see the Help.

7. Restart the IIS service using the Internet Information Services (IIS) administrative 
tool.
Chapter 3 • Installing Analysis Center     47



If You Install SharePoint after Analysis Center
The ability to display reports within a SharePoint site depends on Microsoft Windows 
SharePoint Services or SharePoint Portal Server 2003 software. If you install SharePoint 
after you install the Web Service or the Data Extension, the Windows SharePoint 
Services or SharePoint Portal Server 2003 intercepts requests that should be handled by 
IIS. When this happens, you might be unable to log onto the Analysis Center Console 
or unable to access SQL Reporting Services. 

To solve the problem:

1. Exclude Analysis Center virtual directories, by running the following commands 
from the command prompt:

stsadm -o addpath -url http://localhost/ACWebService 
-type exclusion

stsadm -o addpath -url http://localhost/Reports 
-type exclusion

stsadm -o addpath -url http://localhost/ReportServer 
-type exclusion

For more information about excluding managed paths, see http://
support.microsoft.com/kb/828810/.

2. Open web.config (located by default under inetpub\wwwroot) on the Web 
Service computer, and make the following changes:

a. In the line shown below, change “wss_minimaltrust” to “Full”

<trust level="wss_minimaltrust" originUrl="" />

b. Remove the comment tags (<!-- ... -->) around the following lines:

<add name="Session" 
type="System.Web.SessionState.SessionStateModule"/>

c. Enable the session state flag by adding the following lines between the 
<system.web></system.web> tags

<pages enableSessionState="true" enableViewState="true" 
enableViewStateMac="true" validateRequest="false" />
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If You Install the Web Service On a Non-default 
Web Site

The Web Part expects to find the Web Service at the default Web site. If the Web 
Service is installed on a non-default Web site, configure the Web Part to look for the 
Web Service at the correct location.

To configure the Web Part to look for the Web Service at correct location:

1. On the Web Part computer, n Windows Explorer, go to the IIS root directory 
(C:\Inetpub\www\bin by default).

2. Double-click ACWebPartAdminConsole.exe. The Analysis Center WebPart 
Admin Tool opens.

3. Change Virtual Server and Web Service URL to match the location of the Web 
Service.

4. Click OK.

Upgrading from Analysis Center version 2.6
You can upgrade from Analysis Center version 2.6 to Analysis Center version 2.7, with 
the Data Extension, Data Warehouse, Web Service, Console, and Data Mart, on a 
single computer or in a distributed environment. Before you install Analysis Center 
version 2.7, start the SQL Server Enterprise Manager, and back up the AC_Warehouse, 
AC_OLAP, AC_Configuration, and all other Data Marts. Ensure that each Analysis 
Center component meets the system requirements. For more information, see “System 
Requirements” on page 23. 
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Upgrading on a Single Computer
You can upgrade from Analysis Center version 2.6 to Analysis Center version 2.7, on a 
single computer.

To upgrade all components on a single computer:

1. Log on to the computer where you want to upgrade from Analysis Center version 
2.6 to Analysis Center version 2.7, with an account that has SQL system 
administrator privileges. 

2. If you have installed Analysis Center with the Data Extension, use the Modify 
option of the Analysis Center version 2.6 setup program to uninstall the Data 
Extension.

3. Upgrade SQL Server 2000 to SQL Server 2005 Service Pack 2. For more 
information about upgrading from SQL Server 2000 to SQL Server 2005 Service 
Pack 2, see the SQL Server documentation.

4. Upgrade Analysis Center version 2.6 to Analysis Center version 2.7.

5. Install the Data Extension using the Modify option of the Analysis Center version 
2.7 setup program.

6. Start the Analysis Center Console version 2.7.

Upgrading in a Distributed Environment
You can also upgrade from Analysis Center version 2.6 to Analysis Center version 2.7, 
in a distributed environment.

To upgrade in a distributed environment:

1. If you have installed Analysis Center with the Data Extension, use the Modify 
option of the Analysis Center version 2.6 setup program to uninstall the Data 
Extension from the SQL Server Reporting Services computer.

2. If you have installed Analysis Center version 2.6 on a distributed environment, 
upgrade the Data Warehouse component before you upgrade other Analysis Center 
components.
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- If the Data Warehouse is on a remote server, upgrade the Data Warehouse SQL 
Server 2000 to SQL Server 2005 Service Pack 2.

- If the SQL Server Analysis Services is on a remote server, upgrade SQL Server 
Analysis Services 2000 to SQL Server Analysis Services 2005 Service Pack 2.

- If the Data Mart is on a remote server, upgrade the Data Mart SQL Server 2000 
to SQL Server 2005 Service Pack 2.

- If the Analysis Center Web Service is on a remote server, upgrade from Analysis 
Center version 2.6 to Analysis Center version 2.7 by running the Analysis 
Center 2.7 setup program.

- If the Console is on a remote server, upgrade from Analysis Center version 2.6 
to Analysis Center version 2.7 by running the Analysis Center 2.7 setup 
program.

3. Install the Data Extension using the Modify option of the Analysis Center version 
2.7 setup program.

4. Start the Analysis Center Console version 2.7. 

Note
After uninstalling the Data Extension from Analysis Center version 2.6, the 
Connection string is removed in SQL Server Reporting Services, under Analysis Center 
Data Source. The Connection string is not created after reinstalling the Data Extension 
in Analysis Center version 2.7. You must create the connection string manually in the 
following format : URL=http://<Server Name>/ACWebService to view the reports in 
SQL Server Reporting Services.
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Modifying an Installation
If you start the setup program on a computer that is hosting an Analysis Center 
component, you can also modify the installation by selecting NetIQ Analysis Center 
from the Control Panel Add or Remove Programs utility.

To add additional components:

1. Select NetIQ Analysis Center from the Control Panel Add or Remove Programs 
utility.

2. Select Modify, and then click Next. The Feature Selection dialog box opens, 
showing the components that you can install and components that are installed. 
Installed components are selected by default.

3. Select the additional components that you want to install. Leave the currently 
installed components that you want to keep selected.

4. The Repair operation reinstalls any installed Analysis Center components on the 
computer.

5. The Remove operation removes all installed Analysis Center components. To 
remove a currently installed component during the modify operation, clear the 
selection for that component.

6. When you click Finish on the last dialog box of the program, the uninstallation of 
Analysis Center appears to be complete; however, the removal of SSIS packages and 
SQL Server Agent jobs continues until they are all removed.

When you remove Analysis Center, the removal of SSIS packages and SQL Server 
Agent jobs can take several minutes, depending on the number of packages and 
jobs, and the extent to which your Analysis Center environment is distributed 
among different computers.

There is no option to install the Data Warehouse during a modify operation. This 
safeguard is implemented to help minimize the confusion that would result from having 
multiple Data Warehouses installed in a single Analysis Center environment.
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If you are removing Analysis Center in preparation for a new installation, verify that all 
SSIS packages and SQL Server Agent jobs have been removed before installing the 
program again.

Modifying the Web Service Impersonation Account
If, after installing the Analysis Center Web Service, you need to modify the 
impersonation account information (for example, if the account password has changed), 
use the Internet Information Services Manager to update the Application Pool identity 
for Analysis Center for IIS 6.0. For more information, see the IIS Help.
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Chapter 4

Getting Started with Analysis 
Center
This chapter describes how to begin working with Analysis Center, including which 
tasks to perform first, how to plan out your reports, and how to generate reports.

Getting Started Overview
After you install Analysis Center, perform the following Analysis Center tasks to 
configure Analysis Center and begin generating reports.

1. Implement security. The security settings you make define what is visible to 
each user who logs on to the Console, and what Console functionality is 
available to each user. For more information, see “Configuring Security” on 
page 75.

In addition, Analysis Center provides a utility that allows you to add new 
Analysis Center licenses or remove licenses for the product. For more 
information about this utility, see “Managing License Keys” on page 89.

2. Define the report data. For AppManager reports, add one or more Data 
Sources. 

For more information about adding AppManager Data Sources, see the NetIQ 
Analysis Center for AppManager Management Guide.

3. Plan your reports. For more information, see “Planning a Report” on page 56.
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4. Generate reports. To generate a report, set the context for the report, generate it, 
and then view it in the Results pane. The context of a report refers to the 
computers, data streams, and time frame included in the report. Context may also 
include such measures as average or minimum. For more information, see 
“Generating Live Reports” on page 91, or for a concise overview, see “Generating 
and Deploying a Report: An Overview” on page 57.

If several reports contain related data that is best interpreted when seen together, 
you can group those reports on one page with an Analysis Center feature called a 
“dashboard.” For more information about dashboards, see “Using Dashboards” on 
page 165.

5. Deploy reports. Once you have configured a live report to provide the information 
you need, you can then deploy that report to SQL Server 2005 Reporting Services 
Service Pack 2 to have it run periodically on the schedule you choose. Each iteration 
of the report can be delivered via subscription (by email or written to a file share) to 
one or more users. For more information about deploying reports, see “Deploying 
Reports to SQL Reporting Services” on page 155.

6. Perform administrative tasks. Basic Analysis Center housekeeping consists of such 
tasks as defining holidays, determining the amount of time data is retained in the 
Data Warehouse, and restoring deleted folders and reports. For more information 
about administrative tasks, see “Performing Administrative Tasks” on page 171. 

Planning a Report
Before you begin generating and deploying reports, think about why you want to create 
a report and who will be using it.

1. Decide what purpose the report will have. What information do you want the 
report to show? Have you run the AppManager Knowledge Scripts that will produce 
the data that you want to reveal in a report?

2. In the Navigation pane, look through the sub-folders within the Reports folder. Is 
there already a report that is similar to what you want? Consider the reports in the 
Application Specific folder, as well.
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3. Look at the Configuration Card to see the report properties. Is this report still a 
good match? For more information, see “Understanding the Configuration Card” 
on page 137.

4. Generate the report to see whether it actually does what you want. Select the report 
name in the Navigation pane and click the Execute Report button. The report is 
displayed in the Results pane. For more information about setting report properties 
and contexts, see “Generating Live Reports” on page 91.

5. If the report does what you want, save it under a new, content-specific title in an 
appropriate folder. For more information, see “Saving, Moving, and Renaming 
Reports” on page 134.

6. If appropriate, deploy the report to SQL Reporting Services for access by other 
users. For more information, see “Deploying Reports to SQL Reporting Services” 
on page 155.

7. If none of the existing reports is suitable, look through the Templates folder to find 
a report that is structured the way you want. Save the report under a new title in an 
appropriate folder, customize the report to present the data that you need, and then 
generate the report to check its function. 

Generating and Deploying a Report: An Overview
Analysis Center includes many reports that you can use as-is or alter to suit your needs. 
These pre-configured reports are located in the various category groups within the 
Reports folder in the Navigation pane. This section describes how to generate and 
deploy a Performance report. For more information, see “Generating Live Reports” on 
page 91.

Generating a Performance Report
The following example illustrates the steps involved in creating a Performance Data 
Filtered by KS Over Time report. 
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Before generating this report, make sure that your data source can supply the data that 
your report uses. For the following example, you run a series of AppManager NT 
Knowledge Scripts, setting their parameters to collect data and setting their thresholds 
abnormally low so as to be assured of data and events that could be used in a report. 

1. In the Navigation pane, expand Reports > AppManager > Performance folder and 
select Performance Data Filtered by KS Over Time.

After you select the report, the Tasks pane displays Context, Tasks, and Properties 
tabs. Also, if your data source contains any data, the Results pane displays a preview 
of the report.

2. If you want to view a detailed description of the report, right-click on the report 
title and select Configuration Card. 

The Overview section contains a description of the functions of the report, and 
frequently offers suggestions for customizing the report. The rest of the 
Configuration Card is a graphical representation of the configured contexts and 
parameters that make up the report.

3. On the Context tab, select the Knowledge Script context. Use the Knowledge Script 
context to select the Knowledge Scripts that are generating the data you want 
included in the report. 

In this example, you select the NT_CpuByProcess Knowledge Script.

4. Select the Metric context. Use the Metric context options to define the data for your 
report. In this example, you can view the selections that are related to AppManager 
Knowledge Script data stream legends.

For this example, in the Application(s) list, select NT. In the list of metric options, 
select all of the children of the % CPU Utilization By Process metric.

5. Select the Measures context. The Measures context options allow you to determine 
the statistics used in the report. For this example, use the default. The default is 
Average.

Note
For more information about how to select data in the contexts, see “Using the 
Multi-State Tree Control” on page 96.
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6. Select the Time context. Use the Time context to determine the time frame for your 
report. In this example, select a smaller time frame than the default, which is the 
Last 28 Days.

In the Date Range list, select Last 7 Days.

7. Click Execute Report. The Results pane displays the report.

8. Once you have finished customizing the report, click Report > Save Report As to 
save with a new title under Reports > Performance. Make the new title as explicit as 
possible — it should tell you exactly what purpose this report has.

After you save the report, the Navigation pane displays the report and the Results 
pane displays the title.

Deploying a Report
After you have generated a report, you can then deploy the report to SQL Reporting 
Services. From Reporting Services, you can schedule the report to run periodically. You 
can configure SQL Reporting Services to send the report by email to one or more users, 
or write the report to a file share. You can also view the report by using a Web Browser 
with access to SQL Reporting Services.

For more information about deploying reports, see “Deploying Reports to SQL 
Reporting Services” on page 155.

Tip
To make the functions of the report obvious to users, type a meaningful description 
in the Description field on the Properties tab. Ensure that you accurately describe 
what is shown in the report and include important parameters such as the date 
range the report covers, the metric being used, and the computers being included. 
Although you can see the parameters in the Analysis Center Console, you cannot 
see the parameters you deploy the report to SQL Server 2005 Reporting Services 
Service Pack 2.
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From the Console, if you delete reports that are already deployed, then Reporting 
Services and Web Part may not display such reports correctly.  

To deploy a report:

1. Make sure that you have configured your report to provide the information you 
need. Then save and generate the report.

2. Click Deploy Report. 

3. In this example, accept the default Report Server Location and Report Server 
Credentials information, and then click Deploy.

4. Access the SQL Server Reporting Services home page by entering the following 
address in a Web browser: 

http://<name of SRS Server>/Reports  

5. Expand NetIQ > Analysis Center > Performance. 

6. Click the report you deployed.

Note
To deploy reports to Reporting Services, you must have permission to deploy a report 
from the Console and have Administrator level permissions on the Reporting Services 
computer.
60     Analysis Center User Guide



Chapter 5

Navigating the Analysis Center 
Console

The Analysis Center Console is the interface through which you administer Analysis 
Center and generate reports. You can access the Console elements based on the 
permissions granted to you by an Analysis Center Administrator. Elements for which 
you do not have permission are not visible.

Starting the Console
The following steps describe the process of starting the Analysis Center Console. 
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 To start the Analysis Center Console:

1. In the NetIQ > Analysis Center program folder, click Analysis Center Console.

2. Provide the necessary information to connect to the Analysis Center Web Service:

Field Description

Web Service Enter the URL of the Analysis Center Web Service 
using the format http://computer hosting Web 
Service/Web Service virtual directory.
The URL is defined during installation of the Web 
Service. For more information, see “Installing the 
Analysis Center Web Service” on page 45.

Use Current 
Windows 
Authenticated 
User

Select this option to log on with the Windows account 
you used to log onto the domain.
Clear this option to enable the Login name and 
Password fields.

Login name Enter the login name for the account you want to use to 
connect to the Web Service using the format 
domain\user name.
The first time you start the Console, use an account 
that is a member of the local Administrators group on 
the computer where the Web Service is installed. The 
first time you connect to the Web Service, members of 
this group are added to the Analysis Center 
BUILTIN\Administrators group on the Console 
computer. For more information, see “Configuring 
Security” on page 75.

Password Enter the password for the account you want to use to 
connect to the Web Service.
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3. Click Logon.

The Web Service uses IIS to validate the credentials you use to log on. IIS evaluates the 
credentials of the account according to how you configured the Web Service during 
installation.

If you configured the Web Service to use Windows Integrated Authentication, IIS first 
attempts to validate the user account by its current credentials. If IIS cannot validate by 
that method, IIS prompts for a user name and password until you provide valid 
credentials.

If you configured the Web Service to use Basic Authentication, IIS prompts for a user 
name and password until you provide valid credentials.Identifying Console Elements

The Analysis Center Console consists primarily of the Navigation pane, the Results 
pane, and the Tasks pane. You can move the Navigation and Task panes.

Navigation Pane
The Navigation pane gives you access to the different functional areas of Analysis 
Center. The contents of the Results and Tasks panes change according to the selection 
you make in the Navigation pane.

When you click something in the Navigation pane, it takes a few moments for the panes 
to refresh while the Console queries the Data Warehouse and Configuration database.

Don’t show again Select this option to not display the Logon dialog box in 
the future when:

• You connect to the same Web Service
• You use your current Windows credentials to 

connect to the Web Service
If you start the Console while using a different Windows 
account, the Console displays this dialog box.

Field Description
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The Navigation pane contains the following folders:

• Analysis Center Home 

• Enterprise 

• Views 

• Reports 

• Templates 

Analysis Center Home 
The Analysis Center Home page allows you to manage or access Security, Data Sources, 
and Reports.

Each link has an icon that indicates the configuration status of that particular item. For 
example, if you have not added at least one Data Source, the icon for the Data Sources 
link is yellow.

If you click the Manage Security link, the Manage Security dialog box opens. For more 
information, see “Configuring Security” on page 75.

If you click the Manage Data Sources link, the Data Sources list is displayed in the 
Results pane. For more information, see the NetIQ Analysis Center for AppManager 
Management Guide.

If you click the View Reports link, the Console displays the Reports folder. Expand the 
Reports folder to see available reports.
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Enterprise 
The Enterprise folder contains the following:

• The Active Data Sources folder allows you to see all the currently active Data 
Sources you have defined. For more information about adding AppManager Data 
Sources, see the NetIQ Analysis Center for AppManager Management Guide.

• Database Connections folder allows you to see or modify all of your external 
Database Connections. 

-  The default Analysis Center connection, ACOLAP, is the connection to the 
OLAP database. If you are an Administrator, you can change the Server Name 
and OLAP Catalog values of this connection. However, do not modify the 
connection properties unless you have been instructed to do so by NetIQ 
Technical Support.

To move or change the OLAP server, use the Properties dialog to change the 
values of this connection. Right-click the connection and select Properties. You 
cannot delete this connection.

• The Deleted Data Sources folder allows you to see all the Data Sources you have 
deleted.

• The Pending Data Sources folder allows you to see any added Data Sources that 
have not yet been activated.

When you select the Enterprise folder, the Results pane displays the following objects:

• Green for OK

• Yellow for Warning

• Red for Critical Condition) 

These objects indicate the overall health of your Data Sources, Data Marts, Data 
Warehouse, and Report Server. This allows you to identify potential problems in your 
Analysis Center environment.
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Data Sources 
The health of your Data Sources is determined by the success or failure of the most 
recent ETL job that has run for each Data Source. If any of those jobs has failed, then 
the overall health of your Data Sources is considered as compromised.

When you select Data Sources, a list of Data Sources is displayed in the lower part of the 
Results pane. In the upper part of the Results pane, a Status icon, either green, red, or 
blue, indicating the overall health of your Data Sources is displayed. Green indicates 
success, red indicates failure, and blue indicates an informational message.

The list presents several columns of information:

Column Contents

Name Name of the Data Source.

PreCheck An integer value that indicates:
• The type of pre-check mode you selected when creating the 

Data Source
• Whether or not you selected to activate the Data Source upon 

successful completion of the pre-check.
The possible integer values are:

• 0: No pre-check
• 10: Basic check; do not activate
• 11: Basic check; activate

For more information about Data Source pre-checking, see 
“Managing Data Sources” in the NetIQ Analysis Center for 
AppManager Management Guide.

Oldest Data The date of the oldest data copied from the source database.

Newest Data The date of the most-recent data copied from the source 
database.

Days 
collected

The number of days of data copied from the source database.
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Data Marts 
The health of your Data Marts is determined by the up/down status of the SQL Server 
and SQL Server Agent services for each Data Mart. If any service is down, then the 
overall health of your Data Marts is considered compromised.

When you select Data Marts, a related list is displayed in the lower part of the Results 
pane. In the upper part of the Results pane, a Status icon, either green, red, or blue, 
indicating the up/down status of the SQL Server service, is displayed.

The list presents four columns of information:

Data Warehouse 
The health of your Data Warehouse is determined by the up/down status of the Data 
Warehouse SQL Server, the SQL Server agent, and Analysis Services, and from the 
success or failure of the most recent OLAP Processing job. If any service is down or the 
last OLAP Processing job fails, then the overall health of your Data Warehouse is 
considered as compromised.

When you select Data Warehouse, a related list is displayed in the lower part of the 
Results pane. In the upper part of the Results pane, an icon either green, red, or blue, 
indicating the up/down status of the relevant service, or the success or failure of the last 
OLAP Processing job is displayed. Green indicates success, red indicates failure, and 
blue indicates informational message. The list presents three columns of information:

Column Contents

Server Name of the Data Mart SQL Server.

Database The name of the Data Mart database.

Service The relevant service (SQL Server or SQL Server Agent).

Column Contents

Server The name of the Data Warehouse SQL or Analysis Server.

Service The relevant service (SQL Server, SQL Server Agent, Analysis 
Services, or AC OLAP Processing Job).
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Report Server 
The health of your Report Server is determined by the up/down status of SQL Server 
Report Server and Internet Information Services, and the presence/absence of the 
Analysis Center Data Extension. If either service is down, or the Data Extension is not 
present, then the health of your Report Server is considered compromised.

When you select Report Server, a related list is displayed in the lower part of the Results 
pane. In the upper part of the Results pane, an icon indicating the status of the Report 
Server component is displayed. The list presents two columns of information:

If you have installed SQL Reporting Services in a non-default folder, the status icons for 
the Report Server are red, falsely indicating a critical condition. Use the Reporting 
Services tab of the Options dialog box to identify the correct location of the Report 
Server. Once you indicate the correct location, the status icons for the Report Server 
reflect the appropriate condition. For more information, see “Setting SQL Server 
Reporting Services Options” on page 176.

Views 
Select the Views folder to see a list of all AppManager views that have been imported 
from the various repositories. These views are one method by which data in reports is 
filtered. When you select Views, the following columns of information are displayed:

Column Contents

Service A list of Report Server-related components:
• Report Server
• Analysis Center Data Extension for SQL Reporting Services
• Internet Information Services

Column name Column contents

Data Source Data Sources from which data has been imported.

View Name AppManager views for which data has been imported.

Machine Count Number of computers or servers in each view.
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You can print or export the columns of information by right-clicking in the table, and 
then clicking Print or Export.

You can export to the following formats:

• Microsoft Excel Workbook (XLS)

• Web page (HTML)

• XML file (XML)

• Text file (TXT)

Reports 
Expand the Reports folder to see a tree view of available reports. When you select the 
Reports, the Results pane does not display any information.

When you select an individual report in the Reports folder or a subfolder, the Results 
pane displays the contents of the report based on the default context, or a message that 
no data was found for the report.

You can right-click a folder under the Reports folder to display the commands to create, 
rename, delete, or move a folder.

Viewing Application-Specific Reports
Analysis Center supports application-specific reports such as Exchange, SQL Server, 
VoIP. Analysis Center also allows you to specify security on the application-specific 
reports. For more information about application-specific reports, see “Applying Security 
to Folders in the Navigation pane” on page 87.

Permissions Analysis Center permissions set for each view.

Column name Column contents
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To view application-specific reports:

1. Log on to the Console computer with an administrator account.

2. Start the Analysis Center Console in the NetIQ > Analysis Center program folder.

3. In the Navigation pane, navigate to the AppManager > Application Specific folder.

4. In the Application Specific folder, expand the application folder to view the 
reports. For example, to view the VoIP reports, expand the VoIP folder.Templates 

Expand the Templates folder to see the available report templates in the Navigation 
name. When you select the Templates folder, the Results pane does not display any 
information.

When you select an individual template, either the contents of the report based on the 
default context are displayed, or a message that no data was found for the report is 
displayed.

Results Pane
The Results pane displays information related to the folder you select in the Navigation 
pane, and the contents of reports.

You can sort and group data in a Report table by the different column heads. For more 
information, see “Grouping and Filtering Lists” on page 72. When you sort table data, 
you also sort the corresponding chart, unless the X axis of the chart is ordered by Date/
Time. In this circumstance, the chart is not sorted.

Tasks Pane
The contents of the Tasks pane change depending on what you select in the Navigation 
pane. When you select one of the top-level folders (such as Analysis Center Home or 
Enterprise), the Tasks pane contains a list of tasks appropriate to that selection.
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When you select an individual report, the Tasks pane contains the Context (data) 
controls for the report, a list of report-related Tasks, and the Properties controls for the 
report. You can expand and collapse the individual controls of the Tasks pane by 
clicking the zoom box for each control.

By default, each control is pinned in place. Click the pin icon to unpin a control.

• When a control is unpinned, it is not displayed in the Tasks pane when not in use. 

• To display an unpinned control, point to its tab along the right side of the Tasks 
pane.

• To close a control, click Close.

• To restore a control, select it from the View menu.

Working with Report Folders
In the Navigation pane, folders are containers in which you can keep the reports that 
you create. You can use the folders to group reports by report function (such as Service 
Levels), by the application that you are monitoring, by the recipient of the report (such 
as a specific administrator or business unit), or by myriad other factors that suit your 
reporting needs.

NetIQ Corporation recommends that you create a folder called “Temporary,” “In-
progress,” “Staging,” or some other title that indicates that the folder is a container for 
reports that are not yet ready for “prime-time.” You can leave an in-progress report in the 
temporary folder as long you need, until you are done making all of the context changes 
necessary to produce a report that is exactly what you want. With a temporary folder, 
you can save a report that is not quite finished, come back to it later, and not have to 
wonder where you saved it. When you have finished the report, you can save it in the 
permanent folder in which it belongs.
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Creating a Folder
In the Reports folder, you can create new folders.

To create a new folder:

1. Right-click the Reports folder or any subfolder, then select New Folder. The New 
Folder dialog box is displayed with the new folder name highlighted. 

2. Enter a name for the new folder and then press Enter.

The Navigation pane displays the folder with the name you entered, as a child of the 
folder where you created it.

Moving a Folder
In the Reports folder, you can move the existing folders.

To move a folder:

1. Right-click the folder and select Move Folder.

2. Drag the folder to its new location in the Navigation pane.

3. Click Close.

Grouping and Filtering Lists
The lists of information that are displayed in the Results pane can be grouped according 
to hierarchy. You can expand columns to automatically accommodate all the text in each 
cell, and you can rearrange columns by dragging. You can also filter a list by a number of 
different methods.

Grouping a List
You can create a hierarchical grouping of information in a list by dragging column heads 
to the grouping area at the top of the list. An ungrouped list is displayed by default.
72     Analysis Center User Guide



To group the information in the list by one or more column heads, simply drag the 
column heads into the grouping area. Each successive column head that you drag is 
added as a child of the previous column head.

To clear the grouping, right-click in the grouping area and select Clear Grouping.

To completely expand each item in the list, right-click in the grouping area and select 
Full Expand.

To completely collapse each item in the list, right-click in the grouping area and select 
Full Collapse.

Manipulating Columns
The different lists in the Results pane may not, by default, display all the text in 
individual columns.

You can expand individual columns to display all the text.

To expand a column:

Right-click the column head and select Best Fit.

You can also expand all columns in the list.

To expand all columns:

Right-click a column head and select Best Fit (all columns).

You can rearrange the sequence of columns by dragging the columns from one position 
in the list to another.
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Filtering Lists
You can filter a list by the row contents of a particular column.

To filter a list:

1. Click the drop-down arrow for the column you want to use to create the filter.

2. Select the method by which you want to filter. 

Filter Description

All All rows are displayed.

Custom All rows where this column matches the equation you define. 
For example:
Job name = X
or
elapsed time is less than X
The custom operators like and not like are used with wild 
cards. For example, like *ETL displays all rows where the 
column contains <anything> ETL.

Blanks All rows for which this column contains a blank cell.

Non blanks All rows for which this column does not contain blank cells.

<cell 
content>

All rows for which this column contains this specific cell 
content.

Note
When you group or filter the data in a table (or sort a column by clicking the 
column head), the corresponding chart is updated to reflect those changes. Those 
changes can be saved with the report, with one exception: if the X axis of a chart is 
Date/Time (for example, values distributed along a time line from January 1 to 
January 21), no grouping or sorting of the table columns is reflected in the chart, 
and no grouping or sorting of columns is saved with the report (columns are always 
sorted by Date/Time ascending).
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Chapter 6

Configuring Security
Once you have installed Analysis Center and familiarized yourself with the 
Console, your next step is to implement security. The security settings you make 
define what is visible to each user who logs on to the Console, and what Console 
functionality is available to each user.

You configure Security by creating accounts, assigning those accounts to groups, 
creating permission sets, and then assigning groups and permission sets to folders in 
the Navigation pane.

Each time a user connects to the Web Service, Analysis Center makes an evaluation 
of the Windows user groups on the Web Service computer and the groups defined 
within Analysis Center. In any case where there are matching group names, the 
Windows user is added to the corresponding Analysis Center group.

For example, if the connecting user is a member of the Windows group 
Administrators, then that user is added to the AC_Configuration database as an 
Analysis Center user with administrative permissions (full permissions for Analysis 
Center), and is added to the Analysis Center group BUILTIN\Administrators. If 
the connecting user is a member of the Windows group Users, then that user is 
added to the AC_Configuration database as a non-administrative Analysis Center 
user, and is added to the Analysis Center group BUILTIN\Users.
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Analysis Center has three default groups defined:

• BUILTIN\Administrators (full permissions for Analysis Center)

• BUILTIN\Users

• Analysis Center Everyone (all Analysis Center users belong to this group; this 
group is not exposed)

Understanding the Manage Security Window
To open the Manage Security dialog box, click File > Manage Security or click the 
Manage Security Icon on the toolbar. The Manage Security dialog box allows you to: 

• Add Windows accounts to Analysis Center, give Analysis Center Administrative 
permissions to individual accounts, and enable or disable accounts.

• Create groups of Analysis Center users, add Windows users to those groups, give 
Analysis Center Administrative permissions to individual groups, and enable or 
disable groups.

• Create permission sets that are more restrictive than Administrative permissions, 
and enable or disable those permission sets.

• The enable/disable feature lets you fully organize your security paradigm before you 
implement it. It also allows you to enable/disable individual users, groups, or 
permission sets whenever it might be necessary during the ongoing administration 
of Analysis Center security.

Note
The account you use to install Analysis Center is added as an administrative account 
with full permissions.

The automatic addition of Windows users to Analysis Center groups works for the three 
default Analysis Center groups. If you want to create additional local Windows groups 
and matching Analysis Center groups to take advantage of the automatic addition of 
users, you must use the following naming convention for the Analysis Center groups: 
<Web Service computer name>\<Windows group name>
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Applying Security
Security for Analysis Center is applied to folders in the Navigation pane. For each folder, 
you can define which groups have permissions, and which permission set is enforced for 
each group on that folder.

For example, you may want to restrict access to the Enterprise folder to an 
administrative group with permissions to create Data Sources, while giving broader 
access to various folder under Reports.

Working with Accounts, Groups, and Permission 
Sets

The order in which you create accounts, groups, and permission sets is not important, 
although you add accounts to groups at some point to give those users access to Analysis 
Center functionality.

Creating and Managing Accounts
In order to have Analysis Center group members, you need to first create Analysis 
Center user accounts.

Note
You can enter account names in multiple formats: username, machinename\username, 
domainname\username, etc. And you are allowed to add accounts with the same name 
provided you use different formats: joe, machine1\joe, machine2\joe. But you should 
not do this. If you do, the Analysis Center privileges of the accounts will be restricted to 
the privileges of the account that has the least privileges.
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Creating a User Account
You can create a User Account, modify or remove the account.

To create a user account:

1. Click File > Manage Security.

2. Click the Accounts icon and then click Add.

Complete the Add New Account dialog box as instructed below:

3. Click Create. The new account is displayed in the Manage Security dialog box.

4. Click Close.

Field Description

Name Type the account name.
If you are entering a domain account, use the format 
domain\user name

If you are entering a local account, use the format computer 
name\user name

Description Type the description you want for the account.

Administrator Select Administrator to give this account all permissions for 
Analysis Center.

Enabled Select Enabled to enable the account. By default, the 
account is enabled.
An enabled account has access to Analysis Center. That 
access depends on whether the account is granted 
Administrative permissions, which enabled groups the 
account belongs to, and which permission sets are 
associated with each of those groups when they are 
assigned to folders in the tree view.
An account that is not enabled is ignored by Analysis Center.
78     Analysis Center User Guide 



To modify an account:

1. Click File > Manage Security.

2. Click the Accounts icon.

3. Select an account and then click Modify.

4. Make the necessary modifications to the Name and Description fields, and to the 
Administrator and Enabled options.

5. Click Modify and then click Close.

To remove an account:

1. Click File > Manage Security.

2. Click the Accounts icon.

3. Select an account and then click Remove.

4. Click Close.

Working with Account Groups
Account groups are one aspect of how security is applied to folders in the tree view; 
permission sets are the other aspect. In order to apply security, you must identify the 
groups that have access to a folder and which permission set applies to each group.

Group members are selected from the accounts you create for Analysis Center. For 
more information about accounts, see “Creating and Managing Accounts” on page 77.

To create an account group:

1. Click File > Manage Security.

2. Click the Groups icon and then click Add.
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3. Complete the Add New Group dialog box as instructed below:

4. Click Create. The new group is displayed in the Manage Security dialog box.

5. Click Close.

To modify an account group:

1. Click File > Manage Security.

2. Click the Groups icon.

3. Select a group and then click Modify.

4. Make the necessary modifications to the Name and Description fields, to the 
Administrator and Enabled options, and to the Name list.

5. Click Modify and then click Close.

Field Description

Name Type a name for the group.

Description Type the description you want for the group.

Administrator Select Administrator to give this group all permissions for 
Analysis Center.
A group that has this option selected cannot be deleted.

Enabled Select Enabled to enable the group.
An enabled group is recognized by Analysis Center. The 
permissions associated with the group are enforced for each 
folder to which the group is assigned.
If a group is not enabled, it is ignored by Analysis Center.

Accounts Click Add to open the Browse Accounts dialog box. Select 
accounts from the list, then click Add. The selected accounts 
are added to the User Name list.
Select an account from the User Name list and click Remove to 
remove the account from the group.
Note An account can belong to multiple groups. In this case, the 
most-restrictive set of permissions in effect takes precedence.
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To copy an account group:

1. Click File > Manage Security.

2. Click the Groups icon.

3. Select a group and then click Copy.

4. You cannot copy a group that has the Administrator option selected.

5. Make the necessary modifications to the Name and Description fields, to the 
Administrator and Enabled options, and to the Name list.

6. Click Copy and then click Close.

To remove an account group:

1. Click File > Manage Security.

2. Click the Groups icon.

3. Select a group and then click Remove.

4. Click Close.

Using Windows Groups
After your initial logon to Analysis Center, you can create additional corresponding 
Windows and Analysis Center groups, and configure Analysis Center to add Windows 
users to those Analysis Center groups. When a user logs on to the Console, Analysis 
Center checks local user groups on the Web Service computer to see whether there are 
matches to Analysis Center groups. If it finds a match, Analysis Center adds the 
Windows users to the Analysis Center groups of the same name. The Analysis Center 
groups must use the following naming convention for this process to work:

<Web Service computer name>\<Windows group name>

Note
You cannot remove a group that has the Administrator option selected.
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If you remove a member from a Windows group on the Web Service computer, that 
account can no longer be used to gain access to Analysis Center, but the account will 
remain in Analysis Center until you have removed it through the Manage Security 
dialog. For more information about removing an account, see “Creating and Managing 
Accounts” on page 77.
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 Working with Permission Sets
Granting Administrative permissions to individual users or groups grants full Analysis 
Center permissions. You can define more restricted sets of permissions and enforce 
more granular security for each folder in the tree view.

You can use the following permissions:

Analysis Center has a number of configured permission sets you can use as is, or as the 
basis for your own custom sets.

Category Permission

Administration Assign security rules to a folder

Data Source Add a Data Source
Modify a Data Source
Remove a Data Source

Folder Create a new folder
Delete a folder
Move a folder
Rename a folder

Node View a node

Report Delete a report
Deploy a report
Execute a report
Export a report
Move a report
Print a report
Rename a report
Save a report
Save a report as
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A permission can have one of three states:

• Undefined, which means neither an allow or deny state has been assigned to the 
permission.

• Allow, which means the permission is granted.

• Deny, which means the permission is denied.

To create a permission set:

1. Click File > Manage Security.

2. Click the Permissions icon and then click Add. The Add New Permission Set 
dialog box is displayed.

3. Complete the fields in the dialog box as instructed below:

If you set the permission state at the category (folder) level, then each individual 
permission inherits that state.

You can set a different state for each permission in a category.

Field Description

Name Type a name you create to identify the permission set.

Description Type the description you want for the permission set.

Enabled Select Enabled to enable the permission set.
An enabled permission set is recognized by Analysis Center. 
The permissions defined by the set are enforced for each 
folder to which the set is assigned.
If a permission set is not enabled, it is ignored by Analysis 
Center.

Permissions Set the state for each permission as undefined, allow, or 
deny.
Click once to change the state from undefined to allow; click 
again to change from allow to deny. The icon indicating the 
permission state changes with each click.
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4. Once you have set the state for each permission, click Create. The new permission 
set is displayed in the Manage Security dialog box.

5. Click Close.

To modify a permission set:

1. Click File > Manage Security.

2. Click the Permissions icon.

3. Select a permission set and then click Modify.

4. Make the necessary modifications to the Name and Description fields, to the 
Enabled option, and to the permission states.

5. Click Modify and then click Close.

To copy a permission set:

1. Click File > Manage Security.

2. Click the Permissions icon.

3. Select a permission set and then click Copy. The Copy dialog box is displayed.

4. Complete the fields in the dialog box as instructed below:

Field Description

Name Type a name for the copy of the permission set.

Description Type the description you want for the new permission set.

Enabled Select Enabled to enable the permission set.
An enabled permission set is recognized by Analysis Center. 
The permissions defined by the set are enforced for each 
object to which the set is assigned.
If a permission set is not enabled, it is ignored by Analysis 
Center.
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5. Click Create. The new permission set is displayed in the Manage Security dialog 
box.

6. Click Close.

To remove a permission set:

1. Click File > Manage Security.

2. Click the Permissions icon.

3. Select a permission set and then click Remove.

4. Click Close.

Permissions Set the state for each permission as undefined, allow, or 
deny.
Click once to change the state from undefined to allow; click 
again to change from allow to deny. The icon indicating the 
permission state changes with each click.

Field Description
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Applying Security to Folders in the Navigation 
pane

Once you have set up users, groups, and permission sets, your next step is to apply 
security to the folders in the Navigation pane.

Permissions are calculated cumulatively for the folders in a hierarchy, with the most-
restrictive permissions taking precedence from that folder to its subfolders.

The following illustration is an example: if a group has permission to view the Reports 
and Application Specific folders, and is denied permission to view the Exchange 
folder, then that group does not have access to the Exchange reports (the folder is not 
displayed for that group), but does have access to the SQL Server reports.

If a group has permission to view the Reports folder, and is denied permission to view 
the Application Specific folder, then that group does not have access to either the 
Exchange or SQL Server reports (those folders are not displayed for that group).

When you are denied permission to view a folder, that folder is not displayed when you 
log in to the Console.

If permissions for a folder are undefined, that folder inherits the permissions of its 
immediate parent.

To apply security to a folder:

1. Right-click the folder in the Navigation pane and select Security.  

2. Click Add. 

3. Complete the dialog box as instructed below:

Field Description

Group Select an account group from the list.

Permission Set Select a permission set from the list. This permission set 
is enforced for the group you select.
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4. Click Add. The new information is displayed in the Security dialog box.

5. Click OK.

Understanding the Impact of Your Security 
Settings

The security settings for folders affect the range of functionality available to different 
users. This section discusses the impact of security settings for the following default 
folders:

• “Analysis Center Home”

• “Enterprise”

• “Views”

• “Reports and Templates”

Analysis Center Home
By default, all Analysis Center users have access to Analysis Center. Without access to 
this folder, you cannot see any of the others.

If you deny access to this folder, you effectively deny access to all Analysis Center 
functionality.

Note
You can add multiple account groups. You can also add the same group multiple 
times with different permission sets. In this case, if there are overlapping 
permissions (for example, two different sets that both set permissions for reports), 
the most-restrictive permission set takes precedence.
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Enterprise
Access to the Enterprise folder is necessary to see the Enterprise view, which gives an 
overall look at the health of your Analysis Center environment, and for access to the 
Data Sources folder.

Access to the Data Sources folder is necessary to add and modify Data Sources.

Views
Access to the Views folder is necessary to have access to the various AppManager views 
that have been imported from each repository. Access to views is required to be able to 
select computers for a report when you set the context. For more information about 
views, see “Setting the Group Context” on page 98. 

If you are denied access to the Views folder, the report cannot be displayed as you 
cannot select computers for a report, and there is no data found for the report. You can 
set permissions for individual views under the Views folder. For example, you can limit 
some users to selecting computers from only the SQL or Exchange views.

Reports and Templates
Access to the Reports and Templates folders is necessary to select and generate reports.

You can set permissions for individual folders of reports, or for individual reports, in 
order to control user access. 

Managing License Keys
Use of Analysis Center requires that you purchase licenses for each NetIQ product:

For AppManager, you need a license for each managed clients. For example, if you use 
two AppManager Data Sources, each reporting on 500 servers, you need Analysis 
Center licenses for 1000 managed clients.
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The cost of a license is based on how long the license lasts and on the number of servers 
at your site that are providing data to Analysis Center. Use a utility on the Help menu 
to add or remove licenses. The Manage Licenses window displays your subscription 
information. For more information, see “Analysis Center License Monitoring” on 
page 39.

To add a new license or remove an expired license, click Help > Manage Licenses to 
start the license management utility.

• To add a new license key, type the license key in the New license key field and click 
Add.

• To remove an existing key, select the key in the top pane and click Remove.

A trial license key is installed with the Analysis Center Console. It enables full 
functionality for a limited time. This trial key is displayed in the Manage Licenses dialog 
with the expiration date. Reinstalling Analysis Center will not extend the trial period.
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Chapter 7

Generating Live Reports
After you have defined at least one Data Source and enough time has elapsed that 
the ETL and OLAP processing jobs have both successfully completed, you can 
generate reports based on that data. For running a report successfully, the OLAP 
processing job has to process the context members in the dimensions of the OLAP 
database.

Analysis Center support VoIP reports. For more information, see “Reports” on 
page 69.

There are two types of reports you can run:

• Live, or ad hoc, reports. For a live report, you set the context for the report, run 
the report, and then view the contents of the report in the Analysis Center 
Console.

When you run a live report, that data is cached until you run the report again. 
If you select a report that has been created, you see the cached data. To see 
more-recent data, run the report again.

• Deployed, or scheduled, reports. To generate reports on a schedule, you 
configure the report to display the data in which you are interested (the same 
way you configure a live report), and then deploy the report to SQL Server 2005 
Reporting Services Service Pack 2. The scheduling and distribution of the 
report is handled from the SQL Reporting Services interface. For more 
information, see “Deploying Reports to SQL Reporting Services” on page 155.

Analysis Center provides you the Report Wizard to generate reports quickly. For 
more information, see “Understanding Report Wizard” on page 143.
                                                                                                            Chapter 7 • Generating Live Reports     91



Setting the Context for a Report
The context of a report refers to the computers, data streams, and time frame that are 
the subject of the report, and may also include measures of the data, such as average or 
maximum.

The first time you select a report, it displays any data relevant to its default context. If 
there is no relevant data (for example, no data that fits the default time context), then a 
link to the configuration card for the report is displayed in the Report pane.

Displaying the Context Pane
When you first open Analysis Center, the Tasks pane is displayed on the right-hand side 
of the console with a Context tab and Properties tab displayed at the bottom of that 
pane. Click the Context tab to display the Context pane.

When you select a report in the Navigation pane, its context controls are available on 
the Context pane.

Notes
Depending on the amount of data called for by your context settings, the time required 
to run a query may exceed the timeout settings in the Web.config file, causing the query 
to abort. If you are routinely generating reports that contain large datasets, you can alter 
the timeout settings by editing the Web.config file. For more information, see 
“Changing Timeout Values” on page 187.

You can also change the connection timeout settings for the Web Service Web site. For 
more information, see “Adjusting the Connection Timeout for the Web Service Web 
Site” on page 188.
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There are six different context controls you can use with a report, but not every context 
control is available for every report.

Context Control Purpose

Data Source/
Database 
Connection

Lets you select specific sources of data for your report. 
Data Sources apply to AppManager reports. By default, if you 
have added more than one Data Source, reports reflect all of 
them, but many reports allow you to exclude Data Sources.

Group Lets you select computers for a report. You can select 
computers individually or by group.

Knowledge Script Lets you filter the contents of an AppManager report by 
Knowledge Script. You can see only the Knowledge Scripts 
that are available both in the Cube and the Warehouse.
For example, if you are running an event report, you can limit 
the contents of the report to events raised by a particular 
Knowledge Script (or group of Knowledge Scripts).
You can also use this control in conjunction with the Metric 
context control when it is available.
For example, if you are using both the General_Counter and 
NT_LogicalDiskSpace Knowledge Scripts to monitor the 
percentage of free disk space, you can select both Knowledge 
Scripts, and the comparable metrics returned by each 
Knowledge Script, and use the report to compare the values.
Note Keep in mind that if the Knowledge Script and Metric 
context settings are in conflict with one another, your report will 
have no data. For example, if you set the Knowledge Script 
context to NT_CpuLoaded, but set the Metric context to a data 
stream collected by a different Knowledge Script (such as % 
Physical Memory Usage, which is collected by NT_MemUtil), 
your report will be empty. If you do not want to invoke any 
filtering by Knowledge Script, use the default selection of All 
Knowledge Scripts.
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To display a context control, click its name at the bottom of the Context pane. Only one 
control can be displayed at a time.

Measures For AppManager reports, lets you select which statistics to 
compute for the data:

• Average
• Count
• Maximum
• Minimum
• Standard Deviation
• Sum

Metric Lets you select the data for an AppManager report. You can 
see only the Metric that are available in Cube.
Each data stream is identified by a string (for example, % 
Physical Memory Usage). Generally, there are multiple 
instances of a data stream (for example, % Physical Memory 
Usage from each of your Web servers).

Time Lets you select the time range for a report.
Some AppManager reports have two Time context controls, 
allowing you to compare the same type of data over different 
time periods (for example, the number of HTTP requests to a 
Web site over the past year compared to the past month).
When you are comparing data in two different time periods, the 
filters set for that comparison must be the same; therefore, you 
can set the filter data on the first time context only. Subsequent 
time contexts will have the filter options greyed out.

Context Control Purpose
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Showing and Hiding Context Buttons
It is possible to remove context buttons that you do not need for your report in order to 
make your list of contexts more manageable. The context list is saved with the report. 
Although the contexts may be removed from your view, they are not removed from the 
report. So be aware of how a context is set, before you remove it from your view. Default 
values for a context will not affect your report, but if you have a filter set on a context, it 
will affect your report whether it is hidden or not.

You can also minimize the context buttons to provide more space to view the 
information associated with a context.

To remove the context buttons that you do not need:

1. Click the arrow at the bottom of the Context pane. Then, click Add or Remove 
Buttons.

The list of possible buttons displays.

2. Click the button that you want to add or remove. If the button you click on exists as 
part of your report, it is removed. If the button has already been removed, it will be 
added again.

To show or hide existing buttons:

Once you have decided which buttons you want to include with your report, you can 
easily minimize buttons to make the list temporarily shorter. This is useful when the 
context you are displaying has a lot of information associated with it and you want to see 
as much as you can.

To minimize or maximize a context button, click the arrow at the bottom of the Context 
pane and select either Show Fewer Buttons or Show More Buttons.

When a button is minimized, an icon is displayed at the bottom of the Context pane.
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Using the Multi-State Tree Control
The contexts use a multi-state tree control that lets you make a variety of different 
selections in order to create different orientations of the data. For example, you can 
compare the average memory use of individual SQL Servers to the average for all SQL 
Servers, or you can compare aggregate values by region.

The capability to make different types of selections from different levels of the tree view 
provides a great deal of flexibility in how you present data in a report (for example, 
comparing individual servers to one another, comparing individuals to a group, or 
comparing groups). 

The default selection for a context is the top folder in the context control. For example, 
in the Group context control, the default selection is the All Machines folder; in the 
Measures context control, the default selection is the Average folder. If you do not make 
a selection for a context, the contents of the report will reflect this default selection.

Six different states of selection apply to a folder in the tree; one of the states applies only 
to the Group context.

You click a folder once to explicitly select just that folder, click again to deselect the 
folder and select each of its immediate children by rule, then click a third time to 
deselect the folder and all of its subfolders.

Icons for the other selection states are displayed for parent nodes based on the selection 
states of their children.

State 1: The parent folder is not selected, and none of its children is selected.

If nothing in the tree is selected, then a value is returned for the first item in the tree, in 
this case, All Machines.

State 2: The parent folder is explicitly selected; none of its children (if it has any) is 
selected.

In this case, the Locations folder is selected. Only values for the Locations folder are 
returned.

State 3: The parent folder is not selected, but one or more of its children are selected.

In this case, the Locations folder is not selected, but each of its immediate children is. 
Values are returned for each immediate child folder (Bellevue and Houston).
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This selection icon is displayed under two circumstances: 

• First, when you click an explicitly selected folder. In this case, the folder becomes 
deselected and the immediate children become selected by rule.

• Second, when you explicitly select any child of the parent folder.

State 4: The child folder is selected by rule; none of its children is selected.

To select a folder by rule means to select the child folder by double-clicking on the 
parent folder. When you select a child folder in this manner, you cannot change the  
selection of the child, or that of its children by clicking directly on their nodes. You 
must click again on the parent folder to change the child's selection. 

With this selection option, your report will display data only for the child objects that 
are selected by rule. 

In this case, the Bellevue and Houston nodes are selected by rule (by clicking the 
Locations folder twice). A value is returned for each folder that is selected by rule.

State 5: The folder is explicitly selected, and one or more of its children are selected (by 
any method).

In this case, the Bellevue folder is explicitly selected, and the Bellevue01 folder is 
explicitly selected. A value is returned for the Bellevue folder and for the Bellevue01 
folder.

Selecting Report Data
The Data Source context lets you select which Data Sources you want to use for an 
AppManager report. By default, AppManager reports reflect all Data Sources.

Use the tree control to select the Data Source(s) or Database Connection to report on.

Note
State 4 applies only to the Group context.
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Setting the Group Context
The Group context allows you to select individual servers, groups of servers, or server 
instances to be included in a report. 

When you select an AppManager report, a View menu at the top of the Group context 
control lists the views from the various AppManager repositories from which you want 
to import data.

To set the Group context:

1. For AppManager reports, select a view to display the servers in that view.

If there is more than one instance of a view among the various AppManager 
repositories (for example, IIS or NT), then all servers from all instances of that view 
are displayed.

The Master view may contain other server groups.

2. Select Show Instances if you want to list server instances (for example, SQL Server 
instances) in the tree control.

Setting the Knowledge Script Context
The Knowledge Script context lets you filter the data in an AppManager report by 
Knowledge Script.

Use the tree control to select the individual Knowledge Scripts or groups of Knowledge 
Scripts whose data you want for your report.
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Setting the Measures Context
The Measures context lets you calculate statistics from the data in an AppManager 
report. Use the tree control to select the measures in which you are interested.

Depending on the report, you can select one or more of the following measures. In this 
context, the tree control employs only two selection states: Selected and Not Selected.

Average
Average of data point values within the selected date range (aggregate sum 
divided by aggregate count).

Count
Number of data points collected by a data stream/legend within the selected 
date range.

Maximum
Highest number (value) of all collected data points within the selected date 
range.

Minimum
Lowest number (value) of all collected data points within the selected date 
range.

Standard Deviation
Value that indicates how tightly a set of values is clustered around the average of 
those same values (square root of the product).
[((SumOfSquares - (Sum * Sum / Count)) / (Count-1))]

Sum
Total of all collected data point values within the selected date range.

If you do not select a measure, an average value is calculated by default.
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Setting the Metric Context
The Metric context lets you select the data for an AppManager report. You can filter 
your selections by application and by metric type. If you select too many data streams for 
a report, the chart may become unreadable.

In the reports or the charts, Analysis Center does not display metrics for which the data 
is empty and does not display computers for which data does not exist. For the Reports 
by Over Time, Analysis Center does not display dates when data does not exist only for 
the grid.

For example, if you want to generate a report for the AppManager performance data for 
NT using the Template-Metric by Machine, and if data does not exist for % DC 
Memory Utilization, then Analysis Center will not display this metrics in the report or 
on the chart.

If data does not exist for a few days in a specific range using Template-Data Source by 
Date Time, Analysis center displays the empty values. For example, if you generate a 
report using the Template-Data Source by Date Time from 5/23/2007 to 6/6/2007, 
and if data does not exist for a few days in this date range, Analysis Center displays the 
empty values.

To set the Metric context:

1. Use the Application(s) list to limit data to specific applications. For example, you 
can limit your choices to data collected by AppManager from the Windows 
operating system or from SQL Server.

To select applications, click the drop-down arrow and select from available 
applications.

Note
Analysis Center does not support the Hide Empty Metrics feature for the Service 
Level and Statistical Service Level reports.
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2. Use the Metric Type(s) list to limit data to specific types of data streams (for 
example, AppManager performance data or AppManager event data).

To select types of metrics, click the drop-down arrow, then select from available 
types.

3. Use the tree control to select the data in which you are interested. You can select a 
single data stream, or multiple individual data streams or groups of data streams 
from various levels of the hierarchy.

Setting the Time Context
The Time context lets you specify a time frame for your report. The time context for 
AppManager reports is OLAP-based. When constructing a custom time context, you are 
not allowed to set start or end dates that fall outside the timestamps in the data. Where 
there is a conflict in date ranges, it is resolved in favor of the most restrictive 
(AppManager) time context.

Some reports include multiple Time context controls, which allow you to compare the 
same type of data over different periods of time (for example, the processing time 
required for SQL statements over the past 12 months compared to the last 28 days).

The time range filters are Interval, Start Time, End Time, Days Of Week, US Holidays 
and UTC. For reports that allow you to specify multiple time ranges, the time range 
filters are set in the first control and ignored in the other time controls in order to 
enforce a comparison of like-types of data.

For example, if the Time control specifies hourly intervals for data collected Monday 
through Friday, then these filters do not apply to all time ranges covered in the report 
only for the first one.
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Setting the Predefined Date Range
The Time context control lets you set a custom time range, or choose from a number of 
predefined time ranges. The following table lists the predefined date ranges:

Date Range Time Represented

Last 7 Days The last seven days.
For example, if today is January 7, then the last seven days are 
January 1 to January 7.

Last 12 
Months

The previous twelve months.
For example, if today is any day in January, 2005, then the 
previous 12 months are January 1, 2004 to December 31, 2004.

Last 28 Days The last twenty-eight days.
For example, if today is January 28, then the last 28 days are 
January 1 to January 28.

Last 3 Months The previous three months.
For example, if today is any day in April, then the previous three 
months are January 1 to March 31.

Last 365 Days The last 365 days.
For example, if today is December 31, 2005, then the last 365 
days are January 1, 2005 to December 31, 2005.

Last 4 
Quarters

The previous four quarters.
The first month of the first quarter is set in Tools > Options > 
Enterprise Options. For more information, see “Setting Data 
Warehouse Properties” on page 171. January is the default 
month.
Using the default setting, if today is January 1, 2005, then the 
previous four quarters are January 1, 2004 to December 31, 
2004.

Last 6 Months The previous six months.
For example, if today is January 1, 2005, then the previous six 
months are July 1, 2004 to December 31, 2004.
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Last 90 Days The last 90 days.
For example, if today is December 31, then the last 90 days are 
October 3 to December 31.

Last Month The previous month.
For example, if today is any day in February, then the previous 
month is January 1 to January 31.

Last N Days The previous N days.
The Date Range sets the base time as the day on which the 
report is run and counts back N days from the base time.
For example, if you select N Value as 2 and if today is July 26, 
2007, then Analysis Center generates a report for the date 
range, 7/25/2007 to 7/26/2007.

Last N Months The previous N months.
For example, if you select N Value as 5 and if the current month 
is July, then Analysis Center generates a report for the date 
range, 2/1/2007 to 6/30/2007.

Last N Weeks The previous N weeks.
For example, if you select N Value as 2 and if today is August 
16, 2007, then Analysis Center generates a report for the date 
range, 7/29/2007 to 08/11/2007.

Last Quarter The previous quarter.
Using the default setting of January as the first month of the first 
quarter, if today is any day in April, then the previous quarter is 
January 1 to March 31.

Last Week The previous week (Sunday to Saturday).

Last Year The previous year.
For example, if today is any day in 2005, then last year is 
January 1, 2004 to December 31, 2004.

This Month All days in the current month.
For example, if today is January 15, then this month is January 1 
to January 31.

Date Range Time Represented
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You can select a value for N in the Last N Days, Last N Months, and Last N Weeks 
custom date range options.

To set a value for N:

1. In the Navigation pane, click Reports.

2. From the reports folders, select a report for which you want to modify the report 
properties.

3. In the Context tab, select Time.

4. From the Date Range list, select Last N Days, Last N Months or Last N Weeks.

5. From the N Value list, select a value for N. By default, the range of values for N is 
from 2 to 21.

This Quarter All days in the current quarter.
Using the default setting of January as the first month of the first 
quarter, if today is February 15, then this quarter is January 1 to 
March 31.

Today 12:00 AM to 11:45 PM of the current day.

Yesterday 12:00 AM to 11:45 PM of the previous day.

Date Range Time Represented
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Setting the Custom Date Ranges
You can select a start date and an end date for which you want Analysis Center to 
generate reports. The following table lists the custom date range:

To set the Custom Range option:

1. In the Navigation pane, click Reports.

2. From the reports folders, select a report for which you want to modify the report 
properties.

3. In the Context tab, select Time.

4. From the Date Range list, select Custom Range. When you select Custom Range, 
Analysis Center displays the Start Date and End Date controls.

Selecting an Interval
You can select the interval at which data is aggregated in your report. For example, if 
your time range is 12 months, you may want to aggregate data by month rather than day, 
while a time range of seven days might be more appropriately aggregated by day.

Select an interval from the Interval list.

Selecting a Start and End Time
You can limit the contents of your report to specific hours of the day. For example, if 
you are interested primarily in the level of message traffic on your Exchange Servers 
during regular working hours, you can limit the contents of the report to data collected 
between 8:00 AM and 6:00 PM.

Date Range Time Represented

Custom 
Range

The specified date range.
For example, you can select Start Date as 7/23/2007, End Date as 
7/26/2007 to generate a report.
For more information, see “Setting the Custom Date Ranges” on 
page 105.
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To set a start and end time:

1. Click the arrow on the Start Time list to display the Hour/Minute control.

Hours are listed on the left side of the control. You can select from 00 (Midnight) to 
23 (11:00 PM).

Minutes are listed on the right side of the control. You can select from quarter-hour 
increments (00 to 45).

2. Select an hour.

3. Select a minute increment.

4. Click outside the control to apply your selections.

5. Click the arrow on the End Time list to display the Hour/Minute control.

6. Repeat steps 2 through 4.

Selecting Days of the Week
You can limit the contents of your report to specific days of the week. For example, if 
you are interested primarily in the level of message traffic on your Exchange Servers 
during regular working days, you can limit the contents of the report to data collected 
from Monday to Friday.

To select specific weekdays for your report:

1. Click the arrow on the Days of Week list.

2. Select the weekdays you want for your report and click Apply.
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Including or Excluding Holidays
You can choose to include or exclude U.S. government and business holidays. To see 
holidays:

• Click Tools > Options. The Options dialog box opens.

• Click Holidays.

• In the Select Holiday Set field, select U. S. Business Holidays or U. S. 
Government Holidays.

Select Include U.S. Government Holidays to include those days in your report. Clear 
this option to exclude those days from your report.

Select Include U.S. Business Holidays to include those days in your report. Clear this 
option to exclude those days from your report.

Selecting Local or UTC Time
You can choose to represent data using its local time or Universal Time Coordinated 
(UTC).

Local time can be appropriate when the resources in question are specific to a time 
zone, for example, a file or application server used for a particular office or region.

UTC time can be appropriate for resources that are accessed from multiple time zones, 
for example, Web or database servers.

Select UTC to present data according to UTC time. Clear this option to use local time.

Use the tree control to select the groups and/or servers for your report.

Note
You can make selections from a number of different AppManager views, but you 
have to make them one view at a time. For example, you can make selections from 
servers in the IIS view, and then switch to the SQL view to make additional 
selections.
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Locking a Context
Analysis Center allows you to lock a context, that is, enforce the same context setting 
from one report to the next.

Each report has a default context, and when you switch from one report to another, the 
default context takes precedence unless you have locked the context from a previous 
report.

Locking a context is valuable when you want to, for example, run a number of different 
reports covering the same group of servers for the same time period, or run a report 
covering the same servers and metrics, but for a number of different time periods.

The control for locking a context is displayed in the upper-right corner.

By default, a context is not locked.

To lock a context, click the locking control.
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To unlock a context, click the locking control again. Locking is not observed in 
circumstances in which reports do not include the same context. For example, you may 
lock the Knowledge Script context for a report, and then select another report that does 
not include the Knowledge Script context. In this case, locking is ignored. The 
Knowledge Script context does remain locked, however, if you switch to another report 
with that context.

Refreshing a Context
Some contexts have a refresh feature that allows you to update the items you can select 
for that context while you are configuring a report. For example, you may want to 
refresh the Group context while you are setting it to see whether new AppManager 
views or new server instances have been added, or you may want to refresh the Data 
Source context to see whether new Data Sources have been added.

To refresh a context, right-click in the context control and select Refresh.

Note
Locking the Metric context is only effective when switching between reports whose 
Metric contexts are filtered in the same manner.

Some filtering of metrics is hard-coded in the report. For example, the Average Memory 
Utilization by Server Over Time report is hard-coded to include only metrics 
related to memory use. The effect of the filtering is indicated in the title bar of the 
context control, in this case, by the text Memory Utilization.

In this case, any other report whose Metric context control reads Metric: Memory 
Utilization has the same hard-coded filtering of metrics, and you can effectively lock the 
Metric context between those reports.

Another layer of filtering is achieved when you set the Application and Metric Type 
filters in the Metric context control.

For some reports that employ hard-coded filtering, you can also apply these additional 
filters. For report templates and reports based on templates, you can only filter by this 
method. When these additional filters are applied, there must also be a match between 
reports in order to lock the Metric context.
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Understanding AppManager Control Center 
Management Groups

Analysis Center allows you to include AppManager Control Center (AMCC) 
management groups in the Group context of a report. You can view group of servers 
from single or multiple data sources. For example, you can create an AMCC 
management group to include both Oracle and SQL Server. However, you cannot create 
a view to include both Oracle and SQL Server.

Analysis Center recognizes AMCC management groups using auto-discovery, and then 
displays these groups in the View window and also in the Group context menu. When 
you create new AMCC management groups, Analysis Center can recognize and display 
them.

Analysis Center supports AMCC management group names that are less than or equal 
to 100 characters. However, for the AMCC management group names that exceed this 
limit, Analysis Center truncates the management group names to 100 characters. A view 
name can be same as an AMCC management name. To differentiate between the view 
name and the management group name, Analysis Center prefixes the AMCC 
management group names with MG.

For more information about AMCC, see NetIQ AppManager Control Center User Guide.

Reviewing the Views for AMCC Management Groups
You can create AMCC management groups from the following views:

• AM Standard Views

• AM Snap Views

• AM Dynamic Views

• Rules View

For more information, see the User Guide for NetIQ AppManager Control Center.
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Viewing the AMCC Management Groups
To view AMCC management groups, add the AppManager data source in Analysis 
Center. For more information about adding data sources to Analysis Center, see the 
NetIQ Analysis Center for AppManager Management Guide.

The Configuration Card also displays information about AMCC management groups. 
For more information, see “Understanding the Configuration Card” on page 137.

Viewing the AMCC Management Groups in the View Window
Analysis Center displays the AMCC management groups in the View window. For more 
information, see “Views” on page 68.

To view AMCC management groups from the View window:

1. Log on to the Analysis Center computer.

2. Start the Analysis Center Console in the NetIQ > Analysis Center program folder.

3. Log on to the Analysis Center Console.

4. In the Navigation pane, click Views.

Viewing the AMCC Management Groups in the Group Context
Analysis Center displays the AMCC management groups in the Group context. For 
more information, see “Setting the Group Context” on page 98.

To view AMCC management groups in the Group context:

1. Log on to the Analysis Center computer.

2. Start the Analysis Center Console in the NetIQ > Analysis Center program folder.

3. Log on to the Analysis Center Console.

4. In the Navigation pane, select Reports.

5. Select a report for which you want to add the AMCC management groups.
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6. In the Tasks pane, select Context.

7. In the Group context, select an AMCC management group from the View list.

Setting Report Properties
When you select a report in the tree view, its Properties controls are displayed on the 
Properties tab in the Tasks pane.

To set a property, you do one of the following depending on the property:

• Click the space to the right of the property and type a value.

• Make a selection from a drop-down list.

• Click a [...] button to open a dialog box.

Some properties are read-only.

The following topics discuss the possible properties for a report.

Once you have created a report and retrieved the information in which you are 
interested, you can make changes to the chart properties and then refresh the chart 
without executing the report again. This capability allows you to fine-tune the 
presentation of information in your charts without the overhead of having to run the 
report to see each change.

“Attributes” on page 113 “Chart > AxisX” on page 114

“Chart > AxisY” on page 115 “Chart > Chart3D” on page 117

“Chart > ChartForecasting” on page 118 “Chart > ChartLegends” on page 118

“Chart > ChartSeries” on page 119 “Chart > ChartType” on page 120

“Display” on page 121 “Display > Threshold” on page 123

“Parameters” on page 124 “Creating and Modifying Columns” on 
page 125
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To refresh chart properties after making a change, right-click in the Properties control 
and select Refresh Chart.

Attributes
Report attributes apply to the entire report.

Property Description

(ID) This read-only value is a string identifier used internally by 
Analysis Center.

Comments Enter any string of text that you want to associate with the 
report.

Description Enter a brief description of the report. This description is 
displayed beneath the title of the report in the Results 
pane.

LastModifiedBy This read-only field identifies the last person to save the 
report

ModifyDate This read-only field indicates the last time the report was 
modified in the database

ThresholdEvent Select True or False from the menu. 
If set to True, an entry is made in the Windows Event Log 
of the Web Service computer when a deployed version of 
the report contains a value that exceeds the threshold 
condition you define. For more information, see “Custom” 
on page 124.
You must also enable event logging in the Options dialog 
box (Tools > Options > Enterprise Options). For more 
information, see “Setting SQL Server Reporting Services 
Options” on page 176.
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Chart > AxisX
Changes to these properties affect the X axis of the chart.

Property Description

Font Click the Browse [...] button to set font type and size in 
the Font dialog box.
Note You can also use the following properties to 
manually set values.

Font > Name Select a font name from the menu.

Font > Size Enter a font size in the field. 

Font > Unit Select the unit for the font size (for example, point or 
pixel).

Font > Bold Set to True to display the font as bold. 

Font > GdiCharSet Enter a byte value that determines the GDI (Graphical 
Device Interface) character set used by this font.

Font > 
GdiVerticalFont

Set to True if this font object is derived from a GDI 
vertical font. 

Font > Italic Set to True to display the font in italics.

Font > Strikeout Set to True to display the font in strikeout format. 
You cannot effectively employ the Strikeout and 
Underline properties together when deploying a report to 
SQL Reporting Services. Select one or the other.

Font > Underline Set to True to display the font in underline format. 
You cannot effectively employ the Underline and 
Strikeout properties together when deploying a report to 
SQL Reporting Services. Select one or the other.
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Chart > AxisY
Changes to these properties affect the Y axis of the chart.

IntervalType Determines the interval at which grid lines are drawn.
If set to Auto, the chart control calculates the interval.
If set to Default, the interval matches the Time context 
interval (for example, if the time range is 7 Days, and the 
interval is Day, then seven grid lines are drawn).

LabelInterval Determines the interval at which labels are drawn.
For example, if this value is set to 5, then a label is drawn 
every 5th grid line.

ShowLabels Set to True to display labels. 

Title Enter a title for the axis.

WrapLabels Set to True to wrap label text.

Property Description

AutoScale Set to True to allow the axis to scale as necessary to 
accommodate data.

Font Properties for text along the Y axis. For an explanation of 
each property, see “Font” on page 114.

Property Description
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LabelFormat Select one of the following label formats:
• Default
• Number
• Percent
• Currency
• Scientific
• Hexidecimal
• Decimal
• FixedPoint

Maximum Enter a maximum value for the axis.

Minimum Enter a minimum value for the axis.

Title Enter a title for the axis.

Property Description
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Chart > Chart3D
Changes to these properties affect the presentation of a three-dimensional chart.

Property Description

Clustered For bar and column charts, set to True to display each 
data series separately along the X axis.

Enable3D Set to True to render the chart as three-dimensional. Set 
to False to render the chart as two-dimensional.

LightStyle Select a lighting style for the chart. 
• None
• Simplistic
• Realistic

Lighting affects the shading of the 3D chart components.

Perspective Enter a numerical value (from 0 to 100) that represents 
the perspective of the chart. The higher the value, the 
greater the angle of perspective (background to 
foreground). This property is ignored if RightAngleAxes 
is set to True.

PointDepth Enter a numerical value (from 0 to 1000) that represents 
the depth of chart controls along the Z axis. Applies to 
bar, column, line, pie, and spline charts.

PointGapDepth Enter a numerical value (from 0 to 1000) that represents 
the distance between chart controls along the Z axis. 

RightAngleAxes When set to True, the X and Y axes of a chart are 
rendered at right angles to one another (isometric 
projection). When set to True, Perspective property is 
ignored.

WallWidth Enter a numerical value (from 0 to 30) to determine the 
thickness of the walls of the 3D grid.

XAngle Select a value (from -90 to 90) to determine the rotation 
of the chart around its X axis.
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Chart > ChartForecasting
Changes to these properties affect how a forecast line is displayed in the chart.

Chart > ChartLegends
Changes to these properties affect how the chart legend is displayed.

YAngle Select a value (from -90 to 90) to determine the rotation 
of the chart around its Y axis.

Property Description

Color Select a color for the line depicting forecast value.

DaysForForecasting Select the number of days into the future that you want 
to forecast.

ShowForecasting Set to True to display a forecast line in the chart.

Property Description

Alignment Select the placement of the legend relative to the 
Docking property value. Choose from Near (top or left), 
Center, or Far (bottom or right).

DisableLegend Set to True to disable the legend. If set to False, the 
legend is displayed. 

Docking Select the placement of the legend relative to the chart. 
Choose from Right, Left, Top, or Bottom.
Used in conjunction with the Alignment property. 

Font Set properties for text in the legend. For an explanation 
of each property, see “Font” on page 114.

Property Description
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Chart > ChartSeries
Changes to these properties affect each data series in a chart.

InsideChartArea Set to True to display the legend within the area of the 
chart.

Style Set to Column, Row, or Table to determine how the 
legend text is ordered (top to bottom or left to right).

Property Description

Font Set properties for text in the chart series. For an 
explanation of each property, see “Font” on page 114.

LabelValueAngle Use this property if ShowLabelValues is set to True and 
ShowSmartLabels is set to False. Values from 90 to -90 
determine the angle of the label relative to the chart 
control. 0 degrees is horizontal. Negative values move 
the label counterclockwise; positive values move the 
label clockwise.

MarkerStyle Select the geometric shape used to identify each value 
in a series. Choose None or one of the available 
geometric shapes in the list.

PointWidth Select the relative width of each bar or column in a 
chart. A value of 25, for example, is 25% of the possible 
width.
If you are deploying reports from a Console installed on 
an English locale to a Report Server using a non-
English locale, use the Default setting for this property 
to ensure consistency in how the charts are displayed.
If you are deploying reports from a Console installed on 
a non-English locale to a Report Server using a non-
English locale, the point width in the deployed report is 
always the default, regardless of what value you assign 
this property in the Console.

Property Description
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Chart > ChartType
Changes to this property affect the graphical style of the chart.

ShowLabelValues Set to True to display a numerical value for each 
graphical control in a chart (for example, each bar in a 
bar chart has a label indicating the exact numerical 
value).

ShowSmartLabels Set to True to automatically position data point labels to 
prevent overlapping. If set to True, LabelValueAngle is 
ignored.

Property Description

ChartType Select the graphical style of the chart, such as Area or 
Bar.
For information on the limitations associated with 
different types of charts, see “Chart Limitations” on 
page 138.
If you change the chart type after you have created a 
report, you must click the Execute Report button again 
to ensure your changes. If you do not run a report after 
making changes, the chart legends may be incorrect.

Property Description
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Display
Changes to these properties affect how data is displayed in the report.

Property Description

(Columns) The Column Rules dialog box lets you define a 
separate presentation style for each column of data.
Click the Browse [...] button to open the Column Rules 
dialog box. For instructions on using the editor, see 
“Creating and Modifying Columns” on page 125.

(RowFilter) This field displays a value that represents the custom 
filtering method applied to rows in the table.
The value is derived from the custom filtering equation 
you apply to the table. For more information, see 
“Filtering Lists” on page 74.

(SortExpression) This read-only field displays the column name and 
direction by which the table is sorted.
The value is derived from the sorting you apply to a 
column in a table (ascending or descending). No value 
is derived from Date/Time columns, and no value is 
exported for those columns when you deploy a report.
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NumericFormat Set this property to specify the format of numeric data 
in the report. 
Enter a string format, including the precision specifier 
(the number of significant digits to the right of the 
decimal). For example, F<N>, where N is a positive 
number (a value of F2 displays values to the second 
decimal point (19.55)).
Note The following formats are supported:

• C or c (currency)
• D or d (decimal)
• E or e (exponential)
• F or f (fixed-point
• G or g (general)
• N or n (number)
• P or p (percent)
• R or r (round-trip) Guarantees that the string is 

parsed back to the same numeric value.
• X or x (hexadecimal) In this case, the precision 

specifier indicates the minimum number of digits 
(for example, X8 creates an output like 
0002C45E).

RowLimit Specify the number of rows of data you want to display 
in the report. Enter 0 to display all rows.

ViewMode Select the way in which you want to display data in the 
report (in a chart, in a table, or in a chart and table).

Property Description
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Display > Threshold
Use these properties to set threshold indicator values. When values exceed the 
thresholds you set, those values are color-differentiated in the chart and table in the 
report.

Property Description

Threshold This read-only field identifies the type of threshold set for the 
report.

Above Enter a maximum threshold value. Threshold indicators are 
displayed in charts and tables for data that exceeds this amount. 

Below Enter a minimum threshold values. Threshold indicators are 
displayed in charts and tables for data that falls below this amount. 

Color Highlights the rows or chart values that fail to meet the threshold. 
For instance, use this property to highlight the data that indicates 
machine uptime less than 99 percent. To set the color, click the 
right column next to the color property and select a color from the 
drop-down list.
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Parameters
Parameters are properties for variables in a report. For example, in a Top N Computers... 
report, use the Parameter property to set the number of computers; in a Trend and 
Prediction report, use it to set the number of days into the future for which values are 
predicted.

Custom Enter a Boolean expression that defines the threshold condition 
(for example, [column name] > 90)
You can find the column names in the Column Rules dialog box, 
under Attributes > Source. For more information, see “Creating 
and Modifying Columns” on page 125.
To enter thresholds based on multiple columns, use an expression 
like one of the following:

• [column name] > 35 AND [column name] < 90
• [column name] > 90 OR [column name] > 50

Notes
You can configure a report to write an entry to the Windows Event 
Log when this threshold is exceeded. For more information, see 
“ThresholdEvent” on page 113.
Any values that exceed the threshold are visually distinguished 
from other values in the table (not in the chart).
If your Windows operating system is using a non-English locale, 
you must enclose decimal values in single quotes, for example 
‘4567.8’.

Type Select a threshold type: 
• None (no threshold applied)
• Above (values above threshold are differentiated)
• Below (values below threshold are differentiated)
• Both (Above and Below thresholds are observed)
• Custom (Custom expression is evaluated to determine 

threshold)

Property Description
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Creating and Modifying Columns
When you click the [...] button in the Column property field, the Column Rules dialog 
box opens. Initially, it displays columns in the report that you have selected and 
generated:

Using this dialog box, you can alter the display of data in a column, create new columns 
populated from filtered or arithmetically modified data in other columns, and create 
links to other reports. Set the property controls as indicated below:

Property Description

Attributes

Source This property determines which column of data is affected by 
the rule. Specifying a new name creates a new column.
Type a name for the column or select one from the list.

Chart

LineColor Select a color for the chart control that represents the data.

LineType Select a type for the chart control that represents the data 
(for example, bar or column).
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Expression

Expression Type a user-defined expression to determine the contents of 
the column. You can, for example, enter a new column name 
in the Source property
  Sum Columns 1 & 2
and then enter an expression such as the following to create 
a new column that presents the sum of columns 1 and 2.
<MetricDimensionCol1> +   
<MetricDimensionCol2>

In the example above, MetricDimensionCol1 and 
MetricDimensionCol2 refer to the metric member 
dimension name associated with each column in the 
expression.
To determine the name of a column dimension, click the 
Source drop list to display a list of dimension names.

ExpressionType Select the type of value returned by the expression. To use 
numerical formatting (Format property), you must select a 
numeric expression type.

Format

Format Type a .NET format property (for example, F2 displays the 
data as a floating point value with two decimal places). For 
details about supported numeric formats, see http://
msdn.microsoft.com/library/default.asp?url=/library/en-us/
cpguide/html/cpconstandardnumericformatstrings.asp. For 
details about supported date formats, see http://
msdn.microsoft.com/library/default.asp?url=/library/en-us/
cpguide/html/cpconstandarddatetimeformatstrings.asp.

Hidden Set to True to hide the column. 

Title Type a title for the column.

Property Description
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Links

Cell Use this property to link a report to each cell in the column. 
Click the Browse [...] button to select the report to which you 
want to link a cell. For information, see “Linking Reports” on 
page 136.
 When you click a cell that is a link to another report, the 
linked report is displayed in the Results pane.

Header Use this property to link a report to the column header. Click 
the Browse [...] button to select the report to which you want 
to link the column header. For information, see “Linking 
Reports” on page 136.
When you right-click a column header that is a link to another 
report, the Drill Into Linked Report command is displayed. 
Click that command to display the linked-to report in the 
Results pane. If the column header is used as the chart 
legend, you can click the legend to display the linked-to 
report.

Summary

DisplayFormat

DisplayInFooter Select True or False to display or not display the summary 
information in the footer.

Summary Type Select the type from the drop-down list:
• None - No summary
• Average - Display the numeric average of the column 

data.
• Count - Display the total count of the column data.
• Max - Display the maximum value for the column data.
• Min - Display the minimum value for the column data,
• Sum - Display the sum of a number of columns.

Property Description
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To change the order of column rules (and the order in which columns are displayed in 
the report), select a rule from the Members list, then click the up or down arrow to 
move the rule to a new position.

To remove a column rule, select the rule from the Members list and then click Remove. 

Using the Chart Toolbar 
When you display a report in chart form, a chart toolbar is automatically displayed at 
the top of the chart. The toolbar options work with the cached report, so your changes 
are displayed right away. You do not have to run the report again to see your changes. 
You only need to run the report to update the data not the report presentation.

Toolbar Option Description

Copy Chart Saves a copy of the chart to the clipboard. From 
there, you can paste it into another application.

Print Chart Prints the chart.

Print Preview Displays a preview of the chart before you print it. 
You must have a printer installed.

Export Chart Saves a copy of the chart and opens it in the 
default viewer for that file type.

Toggle Chart Legend Toggles between displaying or hiding the chart 
legend.

Toggle 3D View This icon allows you to toggle between three 3D 
options:

• 3D Chart View
• Cluster 3D
• Right Angle 3D
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Select Chart Type This option allows you to change the type of 
chart.The drop list shows numerous chart options: 
see http://www.dundas.com/Products/Chart/RS/
Features/index.aspx#Chart_Types__ for visual 
illustrations of chart types. Certain chart types 
cannot be combined in one report. For more 
information, see “Chart Limitations” on page 138.

Refresh Chart Refreshes the chart display.

Toolbar Option Description
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Making Easily Read Charts
How you set the properties for a chart determines how easily the information in the 
chart is understood. For example, you may be preparing a report about average memory 
use for the past four weeks in which you are dealing with data based on percentage 
valuesx.x. If you leave the AxisY > AutoScale property at its default setting of True, you 
will produce a chart similar to the following:

The maximum value for the Y axis is calculated based upon the maximum value in the 
report. The chart above gives an accurate representation of the values, but you might be 
able to provide a more meaningful context in which to present that information by 
making the following changes to the AxisY properties:

• AxisY > AutoScale = False

• AxisY > Minimum = 0

• AxisY > Maximum = 100
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In this case, you are setting the Y axis of the grid to match the possible range of values 
(0% to 100%). Your chart would then look something like this:

With a chart like the one above, you can quickly see what percent of the maximum is 
being utilized.
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Another change you can make to the properties to make the chart clearer is to limit the 
number of X axis labels. In a report like this, it might not be essential that each date of 
the last four weeks is explicitly cited. You might be able to do well with every seventh 
date, and so change the AxisX > LabelInterval property from 1 to 7:

If you have labels that are especially long, you can also set the AxisX > WrapLabels 
property to True to have the text wrap.

These are just a few of the ways you can use properties to clarify the information in your 
charts and make them more easily understood. Before you deploy your reports, take 
some time to experiment with the chart properties to be sure you are presenting 
information in the best way for its intended audience.

Once you have the properties set the way you want, be sure to save the report.
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Using Multiple Y Axes in a Chart
You can chart data using a second Y axis. This allows you to chart two metrics for the 
same data in one report. For instance, if you want to chart both the quantity and 
percentage of your data you would use multiple Y axis.

To add a second Y Axis:

Right-click the column that you want to show in the right hand Y axis and select Show 
in Y2 Axis.

Exporting and Printing Charts and Tables
You can export the chart and/or table in a report. Charts can be exported to a variety of 
image formats. Tables can be exported to spreadsheet, Web, and text formats.

To export a chart:

1. On the chart toolbar, click Export Chart.

2. Type a file name for the chart image.

3. Select the image format in which you want to save the chart. Choose from the 
following format options: BMP, EMF, GIF, JPEG, PNG, SVG, and TIFF.

4. Click Save.

To export a table:

1. Right-click in the table and select Export.

2. Type a file name for the table.

3. Select the file format for the table. Choose from the following format options:

• Microsoft Excel Workbook (XLS)

• Web page (HTML)
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• XML file (XML)

• Text file (TXT)

4. Click Save.

To print a chart:

On the chart toolbar, click Print Chart.

To print a table:

Right-click in the table and select Print.

Saving, Moving, and Renaming Reports
You can save, rename, or move a report.

Saving Reports
In order to preserve the original versions of the reports, you cannot save the original set 
of Analysis Center reports under their default names. When you try to save an original 
report, you are forced to save it under another name. Once you have saved it under 
another name, however, you can continue to perform save operations using the new 
name.

When you save a report, it is saved under its current name with its current context.

To save a report, right-click the report and select Save Report.

You can also save a report under another name, which is useful if you want to use an 
existing report as the basis for another report.
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To save a report under another name:

1. Right-click the report in the Navigation pane and select Save Report As. The Save 
Report As dialog box is displayed.

2. In the Save in tree, select the folder in which you want to save the report.

3. In the Report Title field, type a new title for the report.

4. Click Save. The report is saved with its new title in the folder you selected. Its 
current context is preserved.

Moving Reports
You can move a report from one folder to another in the Navigation pane tree view.

To move a report:

1. Right-click the report in the Navigation pane and select Move Report.

2. Drag the report to a new folder.

3. Click Close.

Note
You can right-click a folder and select New Folder to create additional folders.

Note
When you save an AppManager report, the computer and servers that are part of the 
Group context are referenced according to their current AppManager view/group 
locations. If a computer or server is moved to a different view or group in AppManager 
after you have saved the report, you will need to update the Group context to reselect 
those objects in order to continue including their data in the report.
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Linking Reports
You can use the Column Rules dialog box to create links from one report to another. 
For example, you may have a report that illustrates HTTP requests for the past year, 
aggregated by month. You can create links from each monthly value to a report that 
gives the daily values for that month. You can also link from the daily values to reports 
about hourly values.

In order to make effective use of this drill-through capability, you must configure the 
linked reports ahead of time. For example, if you are going to link from a report about 
monthly HTTP requests to reports about daily HTTP requests, you must configure the 
daily reports first, and then link to them from the monthly report. By the same token, if 
you want to link from a daily report to hourly reports, you must configure the hourly 
reports first.

Each time you follow a link from one report to another, a new Multidimensional 
Expressions (MDX) query is made of the Data Warehouse based on the context of the 
new report.

To create links from one report to another, use the Cell and Header properties in the 
Column Rules dialog box. For more information, see “Cell” on page 127 and “Header” 
on page 127.

If you want to deploy a report that contains links to other reports, you need to first 
deploy those other reports. For example, if Report A contains a link to Report B, and 
Report B contains a link to Report C, then deploy the reports in the following order: 
Report C, Report B, Report A.
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Understanding the Configuration Card
The Configuration Card allows you to view the current configuration for a report, 
based on the settings in the Properties and Context tabs when the report was last 
created. The contents of Configuration Card vary depending on the type of report. The 
Configuration Card for your report may not contain each object listed here. The 
following table lists the pane view objects:

Pane View Object Description

Overview Displays an overview of the report along with information 
about the type of data you can present.

Type Displays the database connection type.

Database 
Connection

Displays the database connection name.

Title Displays the report title.

Description Displays the report description.

Modify Date Displays the date of modification.

Comments Displays comments, if any.

DashboardReport This folder contains information about the time context 
parameters.

DashItem This folder contains the entire tree view for each report in 
the dashboard.

Context Folders The individual context folders provide specific information 
about how each context is configured. For example, you 
can tell how the tree control is used to implement 
selections, and which specific objects in the tree are 
selected. The number of folders varies depending on what 
context controls are available for the report.

StandardReport This folder contains information about the SQL query used 
to get data for the report.
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You can view the contents of the Configuration Card.

To view the Configuration Card:

1. Log on to the Analysis Center computer.

2. Start the Analysis Center Console in the NetIQ > Analysis Center program folder.

3. Log on to the Analysis Center Console.

4. In the Navigation pane, select a report.

5. On the Report menu, select Configuration Card.

The Configuration Card displays the AMCC management groups for a report in the 
Context Selections parameter. For example, if a report has MG1 as an AMCC 
management group, then you see Group Selection Group MG-MG1 in the Context 
Selections parameter.

Chart Limitations
The following table identifies the limitations associated with each chart type (for 
example, the chart types that cannot be combined in a report).

Chart Type Limitations

Area Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

Bar Can be combined with only the following chart types:
• Bar
• StackedBar
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Bubble Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

CandleStick Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

Column Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

Doughnut Cannot be combined with any other chart type.
Can only be used to represent a single series of data.

Gantt Can be combined with only the following chart types:
• Bar
• StackedBar

Line Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• Stacked<any type>

Pie Cannot be combined with any other chart type.
Can only be used to represent a single series of data.

Chart Type Limitations
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Point Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

Radar Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie

Can only be used to represent a single series of data.
Does not support scrolling or zooming.

Range Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

An exception occurs when the Enable3D property is set 
to True, and one or more of the columns contains no 
value for the last cell.

RangeColumn Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

An exception occurs when the Enable3D property is set 
to True, and one or more of the columns contains no 
value for the last cell.

Chart Type Limitations
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Spline Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

SplineArea Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

SplineRange Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

An exception occurs when the Enable3D property is set 
to True, and one or more of the columns contains no 
value for the last cell.

StackedArea Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

StackedBar Can be combined with only the following chart types:
• Bar
• StackedBar

Chart Type Limitations
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StackedColumn Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

StepLine Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

Stock Cannot be combined with the following chart types:
• Bar
• Doughnut
• Pie
• StackedBar

Chart Type Limitations
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Understanding Report Wizard
Analysis Center provides a wizard to help you generate reports easily and quickly. The 
Report Wizard allows you to generate reports based on AppManager servers or on 
AppManager knowledge scripts using suitable report templates. You can access this 
wizard from the Tools menu in the Console.

Before you use the Report Wizard, configure the AppManager data source and also 
verify whether the OLAP jobs are processed successfully. Provide the necessary 
information to the Report Wizard to generate reports as per your requirements. Also 
provide a folder name on your computer to save the reports. To access Report Wizard, 
verify whether you have the necessary permissions on the report templates and 
permissions to create, rename, or delete folders.

From the Console, navigate to the folder to view your reports. You can modify these 
report from the Analysis Center user interface. For more information about report 
contexts, see “Setting the Context for a Report” on page 92.

The Report Wizard allows you to select report templates and other parameters for your 
reports. Along with generating the reports based on your inputs, this wizard also saves 
the reports in a folder of your choice. 

To use the Report Wizard:

1. Log on to the Analysis Center computer.

2. Start the Analysis Center Console in the NetIQ > Analysis Center program folder.

3. On the Tools menu, click Report Wizard.

4. In the Welcome to Report Wizard dialog box, select Server Name/Groups or 
Knowledge Script Category to generate reports.

5. Click Next.

6. Complete the wizard by following the instructions on the pages. For more 
information about the fields on the window, see the Help.

7. Click Finish.

8. In the New Report dialog box, select a folder to save the reports.
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9. Type a report name in the Report Title field.

10. Click Save.
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Chapter 8

Understanding Drill-Down Reports
Reports often display large amounts of data. If the data is fairly detailed, displaying 
every detail in one report might not be possible. The best solution to overcome this 
problem is to create a Table of Contents (TOC) report and a drill-down report. The 
TOC report displays computer data for the selected context, and allows navigation 
to the inter-linked drill-down report to view the underlying data. The drill-down 
report displays detailed information about the computer you select.

NetIQ Analysis Center provides templates to create drill-down reports. The drill-
down reports are linked to the TOC report that lists the names of computers. 
When you select a multiple-metrics drill-down template and then select multiple 
metrics, the report displays all the selected metrics. However, when you select a 
single-metric drill-down template, the report displays only one metric that you have 
selected. For more information about each drill-down report, see its Configuration 
Card details. For the multiple-metrics drill-down templates, you can select only one 
measure. However, for the single-metric drill-down templates, you can select 
multiple measures. 

The following table explains the drill-down templates:

Template Purpose

Machine Group 
by Measure

Each row represents a computer group or individual 
computer and each column represents a measure. A 
measure is a statistic derived from the data.

Machine Group 
by Multiple 
Metrics

Each row represents a computer group or individual 
computer and each column represents a metric derived 
from the data.

Measure by 
Date Time

Each row represents a time increment and each column 
represents a measure. 
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Measure by Day 
of Week

Each row represents a day of the week and each column a 
measure.

Measure by 
Hour

Each row represents an hour of the day and each column 
a measure.

Measure by 
Minute

Each row represents an hour of the day expressed in 
minutes and each column a measure.

Metric by Date 
Time

Each row represents a time increment and each column a 
metric (data stream or group of data streams).

Multiple Metrics 
by Date Time

Each row represents a time increment and each column 
represents a metric.

Multiple Metrics 
by Day of Week

Each row represents a day of the week and each column 
represents a metric.

Multiple Metrics 
by Hour

Each row represents an hour of the day and each column 
represents a metric.

Multiple Metrics 
by Minute

Each row represents an hour of the day expressed in 
minutes and each column represents a metric.

TOC List by 
Server

Each row represents Computer details with a link to view 
the drill-down report and each column represents the 
computer metric. The TOC report also has links to other 
reports which are not drill-down reports.

Template Purpose
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Setting the Context for a Drill-Down Report
The context of a drill-down report refers to the Metric, Measure, and Time frame 
included in the report. The following table describes the three different context controls 
you can use with a drill-down report:

Context Control Purpose

Metric Specifies data for a drill-down report.
Each data stream is identified by a string (for example, 
Memory Utilization). Generally, there are multiple instances of 
a data stream (for example,% Physical Memory Usage from 
each of your servers).
The Application(s) list limits data to specific applications. For 
example, you can collect AppManager data from NT or from a 
Report server.
The Metric Type(s) lists the following specific types of data 
streams:

• AM Event Count
• AM Event Occurrence
• AM NT Performance Data

You can select a single data stream, or multiple individual data 
streams, or groups of data streams from various levels of the 
hierarchy.

Measures Specifies statistics to compute for the data:
• Average
• Count
• Maximum
• Minimum
• Standard Deviation
• Sum

Time Specifies the time range for a drill-down report.
Chapter 8 • Understanding Drill-Down Reports     147



Setting the Metric Context for a Drill-Down Report
The Metric context lets you select the data for a drill-down report. You can filter your 
selections by application and by metric type.

To set the Metric context:

1. In the Navigation pane, expand Templates > AppManager Templates > DrillDown 
folders and select the drill-down report template.

2. In the Tasks pane, click the Context tab.

3. In the Context tab, click the Metric context.

4. From the Application(s) list, select the application or applications.

5. From the Metric Type(s) list, select a data stream, or multiple individual data 
streams, or groups of data streams from various levels of the hierarchy.

For more information about Showing and Hiding Context Buttons, see “Showing 
and Hiding Context Buttons” on page 95.

For more information about Using the Multi-State Tree Control, see “Using the 
Multi-State Tree Control” on page 96.

Setting the Measures Context for a Drill-Down Report
The Measures context lets you calculate statistics from the data in a drill-down report. 
Use the tree control to select the measures in which you are interested. 

For more information about setting the measures context, see “Setting the Measures 
Context” on page 99.

Setting the Time Context for a Drill-Down Report
The Time context enables you to specify a time frame for your report. The time context 
for Drill-Down report reports is MDX-based. There is no restriction on the setting of 
start and end date ranges. Where there is a conflict in date ranges, Analysis Center 
resolves it in favor of the most restrictive time context. For more information, see 
“Setting the Time Context” on page 101.
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Setting the Properties for a Drill-Down Report
A drill-down report provides you with the information about a particular computer. 
Parameters are properties for variables in a drill-down report. Therefore, you need to 
specify a name of a computer for the DrillValue parameter in the Properties pane.

To set properties for a drill-down report:

1. In the Tasks pane, click the Properties tab.

2. In the DrillValue parameter, enter the name of the server. 

For more information about Attributes, Chart, and Display in the Properties tab, see 
“Setting Report Properties” on page 112.

Saving the Drill-Down Report 
After updating the settings in the Context tab and the Properties tab, you can save the 
drill-down report using a unique name. To preserve the original version of the report, 
you cannot save the original drill-down report under its default name. When you try to 
save an original report, you are prompted to save it under another name. You can run 
the report after you save it. 

To save a drill-down report:

1. In the Tasks pane, click Save Report As.

2. If you want to create a new folder, right-click and select New Folder.

3. In the Save in tree, select the folder in which you want to save the report.

Note 
It is not mandatory to update the settings in the Context tab to save the drill-down 
report. However, saving of the drill-down report is mandatory before you run it. You 
can view the name of the report only when you select the Column properties when 
using the TOC Report, and link to the drill-down report.
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4. In the Report Title field, type a new title for the report.

5. Click Save. 

For more information about other tasks, see “Saving, Moving, and Renaming 
Reports” on page 134.

Understanding the TOC Report
The TOC report is a parent report and the drill-down report is a child report. These two 
reports are inter-linked. The TOC report displays the summarized data about the 
computers. Using the link provided for each computer, you can navigate to the 
particular computer and view the underlying data. In order to run a drill-down report, 
you must link the TOC report to a drill-down report.

Setting the Context and Group Context for a TOC 
Report

The context of a TOC report refers to the Group, Metric, and Time frame included in 
the report. You can use the Group context to select computers individually or by group. 

You must make settings in the Group, Metric, and Time context to run a TOC report. 
The procedures to make settings in the Metric and Time context are similar to the 
settings you make for a drill-down report.

For more information about setting the Metric context, see “Setting the Metric Context 
for a Drill-Down Report” on page 148, and follow the procedures explained.

For more information about setting the Time context, see “Setting the Time Context for 
a Drill-Down Report” on page 148, and follow the procedures explained.
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The Group context specifies groups of servers and individual servers or server instances 
to include in a TOC report.

When a TOC List by Server template is selected in the navigation pane, a View list at 
the top of the Group context pane lists the views from the various repositories from 
which you have imported data.

To set the Group context:

1. In the navigation pane, expand Templates > AppManager Templates > DrillDown 
folders and select the TOC List by Server report template.

2. In the Tasks pane, click the Context tab.

3. In the Context tab, click the Group context.

4. From the View list, select a view to display the computers in the selected view.

5. Select Show Instances if you need to list computer instances (for example, SQL 
Server instances) in the tree control.

6. In the tree control, select the groups and/or computers.

Saving the TOC Report
After updating the settings, you must save the TOC report using a unique name. To 
preserve the original version of the report, you cannot save the original TOC List by 
Server Report under its default name. When you try to save an original report, Analysis 
Center prompts you to save it under another name. You can run the report after you 
save it. 

Note 
For the TOC report, select only the name of individual computers or the name of 
All Machines. Analysis Center does not support master view, standard view, custom 
view, server groups, or management group (MG) as a linked report for TOC List by 
Server.
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To save a TOC List by Server report under another name:

1. In the Tasks tab, click Save Report As.

2. In the Save in tree, select the folder in which you want to save the report.

3. In the Report Title field, type a new title for the report.

4. Click Save. 

For more information about other tasks, see “Saving, Moving, and Renaming 
Reports” on page 134.

Linking Drill-Down Reports
You can use the Column Rules dialog box to create inter-links from a drill-down report 
to a TOC report. For example, you may have a drill-down report that illustrates average 
CPU utilization by hour for the past year. Before linking the drill-down reports, be sure 
to save the original drill-down report under another name. For more information, see 
“Saving the Drill-Down Report” on page 149. 

To link a drill-down report to a TOC report:

1. In the Navigation pane, select the TOC report.

2. In the Tasks pane, click the Properties tab.

3. In the Properties tab, click Column Rules [1] and then click the [...] button. 
Analysis Center displays the Column Rules dialog box.

4. Navigate to Machine Properties > Attributes > Source. By default, the value of 
Source is Machine. For the drill-down reports, you must select the source as 
Machine. 

5. In the Links attribute, click Cell, and then click the [...] button. Analysis Center 
displays the Pick Report dialog box.
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a. In the Pick Report dialog box, navigate to the appropriate drill-down report 
and select it.

a. Click OK to save the settings and then return to the Column Rules dialog box.

6. In the Column Rules dialog box, click OK.

Executing and Deploying Drill-Down Reports
After you have saved and linked the drill-down and TOC reports, you are now ready to 
run the reports.

You can run live (or ad-hoc) and deployed (or scheduled) reports. To run a live report, 
you set the context, run, and then view the contents of the report in the Analysis Center 
Console. When you run a live report, that data is cached until you run the report again. 
If you select a report that has been created, you see the cached data. To see more-recent 
data, run the report again.

To run deployed reports on a schedule, you configure the report to display the data in 
which you are interested (the same way you configure a live report), and then deploy the 
report to SQL Server 2005 Reporting Services Service Pack 2. The scheduling and 
distribution of the report is handled from the SQL Reporting Services interface.

You must first deploy the drill-down report and then deploy TOC report. When 
deploying the TOC report, select the drill-down report to be linked. 

For more information about deployed reports, see “Deploying Reports to SQL 
Reporting Services” on page 155.

Note 
For a standalone drill-down report, you can modify the DrillValue property. 
However, when you view such a standalone report in SQL Reporting Services, the 
Parameters attribute is empty. For the Parameters attribute to be visible, you must 
deploy a drill-down report using the TOC report and then traverse to the child 
report through the TOC report.
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To run the drill-down reports:

1. In the navigation pane, select the TOC report which is linked to a drill-down 
report.

2. In the Tasks pane, click Execute Report.
The TOC report displays details of computers performance, both graphically and in 
table format as per the settings in the TOC report.

3. To view the drill-down report for a particular computer, click the computer link in 
the report table.
The drill-down report displays details of the particular computer, both graphically 
and in table format as per the settings in the drill-down report.
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Chapter 9

Deploying Reports to SQL Reporting 
Services
Once you have configured a report to provide the information in which you are 
interested, you can then deploy that report to Microsoft SQL Server 2005 
Reporting Services Service Pack 2 to have it run periodically on the schedule you 
choose, and have each iteration of the report delivered via subscription (by email or 
written to a file share).

Once you have deployed a report to SQL Reporting Services, further management 
of that report is carried out from the SQL Reporting Services interface. In order to 
successfully manage reports you have deployed, you need to have a thorough 
working knowledge of SQL Reporting Services. Consult Reporting Services Books 
Online, the Microsoft documentation, which is provided with a default installation 
of SQL Reporting Services.

Security Considerations for Deploying a Report
Be aware that when setting report permissions in the Analysis Center console, in 
order for a user to deploy reports to Reporting Services, they must have permission 
to deploy a report from the console and have Administrator level permissions on 
the Reporting Services computer.
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Unsupported Chart Properties
Several of the chart properties that you can configure for live reports in Analysis Center 
are not supported in SQL Reporting Services. These include:

When you deploy a report with any of these properties, you are issued a warning that 
the property is not supported in SQL Reporting Services, but you can proceed with the 
deployment. For Analysis Center chart types that are not supported, SQL Reporting 
Services substitutes a chart type. Other unsupported properties are simply left out of the 
SQL Reporting Services version of the report.

Difference in Column Display
The Analysis Center console removes empty columns from charts. Empty columns may 
exist, for example, because you have selected a computer in the Group context that is 
not yet supplying data for a selection you have made in the Metric context.

When you deploy a report, SQL Reporting Services includes any empty columns in the 
charts. This is necessary so that columns that might be empty at the time of deployment 
can include data when it later becomes available.

• BoxPlot • CandleStick • Gantt

• Point • Radar • Range

• RangeColumn • SplineArea • SplineRange

• StepLine • Stock • ChartForecasting

• ChartMovingAverage • LabelValueAngle • ShowSmartLabels=False

• PointGapDepth (for 
values other than 
10)

• PointDepth (for 
values other than 
50)
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Deploying Linked Reports
If you want to deploy a report that contains links to other reports, you need to first 
deploy those other reports. For example, if Report A contains a link to Report B, and 
Report B contains a link to Report C, then deploy the reports in the following order: 
Report C, Report B, Report A.

For details, see “Linking Reports” on page 136.

Deploying a Report
You cannot deploy a report that does not run properly, for example, due to an invalid 
context setting.

In order to deploy a report with its current properties, save the report before you deploy 
it. If you do not save the report with its current properties, it will be deployed with 
whatever properties were last saved.

To deploy a report to SQL Reporting Services:

1. Right-click the report in the Navigation pane and select Deploy Report.

The Report Server Credentials pane is part of the Deploy Report dialog.
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2. Complete the fields on the Deploy Report dialog including the Report Server 
Credentials pane as instructed below:

Field Description

Report Name Type the name you want for the report.

Report Server 
Location

Select a URL for a Report Server. 
If the URL you want is not listed, select New from the 
drop-down list to open the New Report Server Location 
dialog box, enter the URL in the dialog box, and then click 
OK.
Select My Reports radio button to have the report listed in 
the My Reports folder assigned to the account under 
which the Analysis Center console is running. 
Select Folder radio button to enter a specific public folder 
name in which to list the report. The default is 
NetIQ\Analysis Center\XXX\XXX\...
where XXX\XXX\... is the names of the sub-items under 
the report tree.
Click the Show last deployment information link to 
expand the Deploy Report dialog box and display the 
information that was entered the last time the report was 
deployed.
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Report Server 
Credentials
Note The account 
used to connect to 
Analysis Center must 
be an Analysis 
Center account with 
Execute a report 
permission.

Select the method by which SQL Reporting Services 
connects to Analysis Center to run the report. 

• Select the Credential supplied by the user running 
the report radio button to have that user prompted 
for a user name and password when the report is run.

• Select the Windows NT Integrated Security radio 
button to use the credentials of the user running the 
browser in which SQL Reporting Services is running.

Note If you use this option in an environment where the 
Analysis Center components are distributed among 
different computers, you may encounter a report-
processing error due to the Windows “double-hop” issue 
in which Windows security credentials are not recognized 
for more than one connection (credentials are recognized 
from Server A to Server B, but not from Server B to Server 
C). If multiple connections are required to process the 
report, use the Select shared Report Server Data Source 
option, or for information about storing credentials on the 
Report Server, see “Reporting Services error “An error 
has occurred during report processing ...”” on page 197.

• Select the Select shared Report Server Data 
Source radio button to select from a list of shared 
Data Sources specific to the Report Server to which 
you are deploying the report. If a shared Data Source 
does not exist, you can create one. 

Note Use this option if you want to also enable a 
subscription. For more information, see the next 
parameter and description. 

• Click the Edit link to open a browser displaying the 
SQL Reporting Services interface for editing the 
shared Data Source. You can then modify the 
credentials used by the Data Source.

Include report 
configuration card

Select the check box to include the configuration card with 
the deployed report.

Enable subscription Select the checkbox to distribute the report by means of a 
subscription (via email or file share).

Field Description
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Delivery Method tab Use the options on this tab to determine the manner in 
which the report subscription is delivered to recipients.

Delivered by Select Report Server File Share from the drop-down list 
to have the report delivered to a folder on a file share.
Select Report Server E-Mail from the drop-down list to 
have the report delivered by email to a list of recipients.

File Name Type the file name you want to use for the report. The 
default file name is the report name.

Add a file extension 
when the file is 
created

Select this check box to add a three-character file 
extension to the file name. The extension is determined by 
the render format you select.

Path Type the UNC path to the file location (for example, 
\\computer name\C$\report folder).
Specify an existing folder.

Render Format Select the type of file that will be created. Select a type 
that corresponds to the application in which the report will 
be viewed.

Credentials used to 
access the file share

Supply the credentials used to write to the file share.
• For User Name, enter the user name for the account 

used to write to the file share. Use the format 
domain\username.

• For Password, enter the password for the account 
used to write to the file share.

Note The account you identify must have write 
permissions to the folder. The user name and password 
must be correctly identified in the properties of the Report 
Server Data Source you are using for the report.

Field Description
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Overwrite options Select the manner in which subsequent iterations of the 
report are saved.

• Select the Overwrite an existing file with a newer 
version radio button to overwrite an existing version 
of the report with a new version.

• Select the Do not overwrite the file if a previous 
version exists radio button to prevent an existing 
version of the report from being overwritten.

• Select the Increment file names as newer versions 
are added radio button to add a time stamp or 
version number to each iteration of a file with that has 
the same name.

Report Server E-Mail options

To
CC
Bcc

Type the email address of each recipient of the report 
(primary, copy, or blind copy). Separate multiple 
addresses with a semicolon (;).

Reply-To Type the email address to which replies are sent.

Subject Type the subject line of the email.

Include Report Select this option to embed or attach a copy of the report.
Note If you do not select either this option or the Include 
Link option, only the text in the Subject line is sent.

Render Format Select the type of file that will be created. Select a type 
that corresponds to the application in which the report will 
be viewed.

Include Link Select this option to include the URL for the report in the 
email.
Note If you do not select either this option or the Include 
Report option, only the text in the Subject line is sent.

Priority Select the importance level of the email (Low, Normal, or 
High).

Field Description
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3. Click Deploy.

Comment Type the text you would like as the body of the email.

Schedule tab Use the options on this tab to determine the schedule on 
which the report is rendered and delivered to recipients.

Once Select this option to render and deliver the report only 
once.

Repeat after this 
number of weeks

Specify the weekly frequency at which the report will run 
(for example, a value of 1 means the report will run every 
one week; a value of 2 means the report will run every 
second week).

On day(s) Select the days of the week on which the report will run.

Start time Select this option to specify the time at which the report 
will run.
Specify hour and minute values, and select either AM or 
PM.

Run Now Select this option to run the report immediately.

Start on Specify the date on which the schedule begins. Use the 
format mm/dd/yyyy.

End on Specify the date on which the schedule ends. Use the 
format mm/dd/yyyy.

Notes
If you make changes to a report in the Analysis Center Console, you will have to deploy 
the report again before those changes are displayed in the deployed version of the 
report. From the Console, if you delete reports that are already deployed, then 
Reporting Services and Web Part may not display such reports correctly.

Field Description
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Chapter 10

Configuring Reports to Display in 
a SharePoint Web Part
Analysis Center supports Microsoft SharePoint technology. The Analysis Center 
SharePoint web part can be added to any web part page. It allows you to display 
individual reports or create dashboards using multiple Analysis Center web parts on 
a page. You can build and customize these dashboards using drag and drop, like any 
SharePoint web part, and you can mix Analysis Center data with other content in a 
web part page. This chapter explains how to configure the Analysis Center Web Part 
to display reports at a SharePoint.

Displaying Reports Within a SharePoint
If you have the Analysis Center Web Part and SharePoint installed, you can display 
your reports within a SharePoint Web Part. For more information on installing and 
configuring the Analysis Center Web Part, see “Installing the Web Part” on page 47.

To display a report in SharePoint Web Part:

1. Go to the SharePoint web page where you want to display your report. 

2. Click Modify Shared Page > Add Web Parts > Browse.

3. Click Virtual Server Gallery. 

4. From the Web Part List, select NetIQ Analysis Center and drag the link onto 
the page. A section entitled Analysis Center Web Part is displayed on the page.

5. To configure the web part for displaying reports, click Configure. The Analysis 
Center Navigation Pane is displayed.

6. Expand the Reports folder and find the report you want to display on this Web 
Part.
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7. Select the report and click Apply or OK located at the bottom of the Configuration 
pane. The report displays within the Analysis Center Web Part. You can configure 
the display of your report through the Configuration pane.

8. To modify the report display, click Configure. For instructions on customizing the 
web part, see the SharePoint documentation.

Working with Analysis Center Reports that are 
Displayed on the SharePoint Web Part

SharePoint provides the ability to modify the look and feel of your report through the 
Configuration pane; however modifications made to the report data, or deleting a 
report and adding a new one are all tasks handled by the Analysis Center Console.

Adding and Modifying New Reports
When you add or save a new report in the Analysis Center Console, the new report 
shows up in the NetIQ Analysis Center Web Part Navigation Tree within the 
SharePoint Configuration pane. Select the report from the Navigation Tree and add it 
to the Analysis Center Web Part. 

If you modify the context of a report from the Analysis Center Console, the context 
changes are not seen in the same report on SharePoint. You must save the modified 
report under a new name and display that report separately on the Web Part.

Deleting Reports
If you delete a report from the Analysis Center Console that is being displayed within 
the Web Part, the Analysis Center Web Service returns an error code and a message is 
displayed at the Web Part stating that the report is no longer available. To fix this, you 
can either select a different report to display at the Web Part or remove the Web Part 
from the Web Part page.Modifying Report Context in the Analysis Center Console
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Chapter 11

Using Dashboards
The Analysis Center Dashboard feature allows you to group a number of reports 
together on the same page, which makes it easy to see related data at a glance. For 
your convenience, Analysis Center offers several out-of-the-box dashboard reports. 
In the Navigation pane, the AppManager dashboards are located under Reports > 
AppManager > Dashboards.  

For more information about specific dashboards, see the respective management 
guide. AppManager dashboards are listed in the NetIQ Analysis Center for 
AppManager Management guide.

Although there are dashboard reports specific to each product, it is possible to 
create a dashboard that includes reports from more than one product. For more 
information on creating your own dashboard, see “Configuring a New Dashboard” 
on page 166.

An open dashboard displays a thumbnail version of each of its member reports. 
From within the dashboard, click the title of a member report to view the full 
report. If you change a report in a dashboard, and then redeploy the report, you 
also need to redeploy the dashboard report. 

You can use any dashboard as the basis for another by saving it as another name, 
and then adding and deleting the reports in which you are interested. 

You can display either a chart or a table for each individual report.

You can set a context for the dashboard as a whole, and then set the properties for 
each individual report to observe either the dashboard context or the individual 
report context. If you are going to have any report use its own context, configure 
that context and save the report before including it in the dashboard.
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Configuring a New Dashboard
You use an existing dashboard as the basis for a new one.

To configure a dashboard:

1. In the Navigation pane, expand the Reports folder.

2. Expand the AppManager folder, depending on the product dashboards with which 
you are working.

3. Expand the Dashboards folder for the selected product.

4. Select an existing dashboard to use as the basis for your new one.

5. Set the context for the dashboard the same way you set the context for an individual 
report. For more information, see “Setting the Context for a Report” on page 92.

Notes
In order to display the context controls for a dashboard, at least one of the reports 
included in the dashboard must share at least one context with the overall dashboard. 
For example, the Group or Time context. To configure a report to share a context with 
the overall dashboard, use the Configure Dashboard Members dialog box. For more 
information, see “Adding Reports to a Dashboard” on page 168.

When you configure individual reports to share contexts with the dashboard as a whole, 
you can, for example, compare different types of data for the same group of computers 
over the same time range. For example, CPU and memory use for 10 different Web 
servers over the last month.
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6. Set the properties for the dashboard to determine such attributes as the layout of 
the dashboard, which reports are included in the dashboard, and whether those 
reports use the context set for the dashboard or their own specific context settings.

Property Description

Attributes General attributes for the dashboard

(ID) A read-only string identifier used internally by Analysis 
Center

Comments Click in the field and enter any text string.

Description Click in the field and enter a brief description of the 
dashboard

LastModifiedBy A read-only attribute that identifies the last person to 
save the report

ModifyDate A read-only attribute that identifies the last time the 
report was modified in the database

ThresholdEvent Set to True to enable events when reports contain 
values that exceed the threshold you set. Events are 
written to the Windows Event Log on the Web Service 
computer.

Dashboard Layout, reports, and context usage.

(DashItems) Indicates the number of reports included in the 
dashboard.
Click the Browse [...] button to open the Configure 
Dashboard Members dialog box. For instructions 
adding reports to a dashboard, see “Adding Reports to 
a Dashboard” on page 168.
Note
The Configure Dashboard Members dialog box lets you 
select reports for the dashboard, determine how a 
report is displayed in the dashboard, and which 
dashboard context settings are observed by the report.
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Adding Reports to a Dashboard
You use the Configure Dashboard Members dialog box to add reports to a dashboard. 
From the Properties tab for a selected dashboard report, click the Browse [...] button in 
the DashItems field. 

The Configure Dashboard Members dialog box lists the reports that are currently 
included in the dashboard. When you select one of those reports, its dashboard 
properties are displayed.

To add a new report to the dashboard:

1. Click Add.

2. In the Attributes > Report property, click Browse [...].

3. Select a report from the tree view, then click OK. The tree view of reports displayed 
in the Pick Report dialog box is the same as the one displayed under the Reports 
folder in the Navigation pane.

To remove a report from the dashboard:

1. Select the report in the Members list.

2. Click Remove and then click OK. 

To set the dashboard properties for a report:

Select the report in the Members list to display its properties.

Property Description

Attributes General attributes for the report as it is displayed in the 
dashboard.

FullRow Set to True to display a report across a full row of the 
Results pane.
For dashboards, the Results pane is effectively divided 
into two columns and an infinite number of rows. If the 
FullRow value is True, a report is displayed across a full 
row, or both columns.
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Report Click the Browse [...] button, and then select a report 
name from the list.
Use this list to select a report after you click the Add 
button.

RowLimit Indicates the number of rows of data from the recordset 
to display in the report.
Enter a positive or negative number.

• Use a positive value to display the first N rows in the 
recordset (for example, 5 displays the first five rows 
in the recordset).

• Use a negative value to display the last N rows in 
the recordset (for example, -5 displays the last five 
rows in the recordset).

Viewable This read-only field indicates view permissions:
• Allowed: the current user has permissions to view 

the report.
• Denied: the current user does not have permission 

to view the report.
• Not Available: the report is not available because it 

has been deleted.

ViewMode Select whether the report is displayed as a Chart or 
Table. If you want to have both a chart and table for a 
report, you have to add two instances of the report to the 
dashboard, and then display a chart for one and a table 
for the other.

Visible Set to True to determines whether a report is visible in 
the dashboard.

Context Context settings for the report as it is displayed in the 
dashboard

Property Description
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Drilling Through Dashboard Reports
If you want to see the full version of a report that is part of a dashboard, simply click the 
title of the report. The full version of the report is then displayed in the Results pane, 
allowing you to see both the chart and table if they are included. You can also drill 
further into the individual report if you have any linked reports that provide more 
detail. For more information, see “Linking Reports” on page 136.

Deploying Dashboard Reports
You deploy a dashboard report the same way you deploy an individual report. For more 
information, see “Deploying Reports to SQL Reporting Services” on page 155.

<any context> Select whether the report uses the dashboard context 
setting (Shared) or its own context setting (Not Shared).
For example, you might want the report to use the 
dashboard Time context (Shared), but use its own Group 
context (Not Shared).

Notes
You cannot deploy a dashboard that contains no individual reports.

You cannot deploy a dashboard that contains any individual reports that will not run 
properly, for example, due to an invalid context setting.

Property Description
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Chapter 12

Performing Administrative Tasks
This chapter discusses the tools you can use to perform tasks associated with the 
administration of Analysis Center.

Setting Data Warehouse Properties
You can configure the following Data Warehouse options:

• The first month of the first quarter. You can use this to define a calendar or 
fiscal year

• Whether to enable the Analysis Center (OLAP Processing) job

• The schedule on which the OLAP Processing job runs

To set Data Warehouse options:

1. On the Tools menu, click Options. 

2. From the list of Enterprise Options, select Data Warehouse.

3. Complete the fields on the window. For more information about fields on a 
window, see the Help.

4. Click OK.
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Setting Default Data Source Values
Use the Default Values options to set default values for fields in the Add Data Source 
wizard.

To set default values:

1. On the Tools menu, click Options.

2. From the list of Enterprise Options, select Default Values.

3. Complete the fields on the window. For more information about fields on a 
window, see the Help.

4. Click OK.

Setting Holiday Options
The Holiday options allow to you manipulate two sets of holidays:

• U.S. Business Holidays

• U.S. Government Holidays

Managing a Holiday Set
You can rename a holiday set, and you can edit the individual days that make up the 
holiday set. You can also delete an existing holiday set. 

To rename a holiday set:

1. On the Tools menu, click Options.

2. From the list of Enterprise options, select Holidays.

3. If you want to modify a holiday set other than the displayed set, select the set 
under the Select Holiday Set list.
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4. Click Rename.

5. Type the new name of the holiday set and then click OK.

To edit an existing member of a holiday set:

1. On the Tools menu, click Options.

2. From the list of Enterprise Options, select Holidays.

3. From the list of holidays, select the one you want to edit (for example, Labor Day), 
and then click Edit.

4. Type a date and description of the holiday. 

5. Click Update, and then click OK.

To add a holiday:

1. On the Tools menu, click Options.

2. From the list of Enterprise options, select Holidays.

3. If you want to add a holiday set, select the set under the Select Holiday Set list.

4. Type the date and description of the holiday you want to add in the Holiday Date 
and Holiday Description fields. 

5. Click Add and click OK.

To delete a holiday:

1. On the Tools menu, click Options.

2. From the Select Holiday Set drop list, select the set from which you want to delete a 
holiday.

3. Select the holiday from the list, and then click Delete.

4. Click OK to close the Options dialog box.
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Setting Report Management Options
The Report Management options let you:

• Restore folders and reports you have deleted from the Reports folder.

• Export reports to edit the XML, perhaps to make a change in a test or laboratory 
environment.

• Import reports, perhaps to include any altered reports in the Navigation pane.

• Migrate Analysis Center version 2.6 reports to their equivalent Analysis Center 
version 2.7 reports. 

To use the Report Management options:

From the list of Enterprise Options, select Report Management.

To restore folders or reports you have deleted:

1. Select Restore report(s).

2. Expand the tree view to display the folders and/or reports you have deleted.

Deleted folders and reports are identified by a red X and a cleared check box.

Folders and reports that are currently displayed in the Console are identified by 
selected check boxes. You cannot change the selection state for these items.

3. Select the reports and folders you want to restore.

4. Click Restore and then click OK. The folders and reports are restored to their 
original locations under the Reports folder in the Navigation pane.
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To export reports:

1. Select Export report(s).

2. Expand the tree view to display the reports you want to export.

3. Select the check box for each report you want to export.

4. Click Export.

5. Navigate to the folder in which you want to save the reports.

6. Click Save, and then click OK to close the Options dialog box.

To import reports:

1. Click Import.

2. Navigate to the folder that contains the reports you want to import, and select those 
reports.

3. Click Open, and then click OK to close the Options dialog box.

Note
By default, the Export Reports option is disabled in a distributed environment. For 
more information, see the NetIQ Analysis Center Release Notes.

Note
If you are exporting multiple reports, they are saved as a single file, with a single file 
name. The XML for each report is contained in that file. Edit that file to edit the 
reports, and then import that file to make the new versions of the reports available 
in the Console.

Note
Imported report contexts and properties are not reflected immediately in the 
Console. You will see any changes after you select any other report in the Navigation 
pane, and then return to and run the imported report.
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To migrate reports:

1. Click Migrate.

2. After the Analysis Center 2.6 reports are migrated, a notepad file displays the 
following details:

- Details of the migrated reports.

- Reports that are not migrated.

3. Click OK to close the Options dialog box.

Setting SQL Server Reporting Services Options
You can configure four SQL Server Reporting Services options:

• The URL of the Report Server (the Report Server is created when you install SQL 
Reporting Services)

• The default folder on the Report Sever to which deployed reports are saved

• Whether threshold exceptions in reports generate events

• Whether to include the report configuration card

Note
• This process does not migrate any custom reports.

• In x86 computers, migration of reports is performed only after a successful 
upgrade from Analysis Center version 2.6. The reports that you have saved using 
the Saved As option from Analysis Center version 2.6 are migrated to their 
equivalent Analysis Center version 2.7 reports.

• Migration is not associated with the tree-view in the Report Management 
section. Clicking Migrate migrates all the reports in the database that are not 
compatible with Analysis Center 2.7, and were originally supplied with Analysis 
Center.
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To set Reporting Services options:

1. From the list of Enterprise Options, select Reporting Services.

2. Complete the fields as instructed below:

3. Click OK.

Field Description

Default Report Server 
Location

Type the URL of the Report Server.
Note If the Data Extension and SQL Reporting 
Services are installed on a computer whose IIS 
Server has Secure Sockets Layer implemented, 
make sure the URL begins with https (not http).

Default Report Server Root 
Folder

Type the name of the default folder in which 
deployed reports are saved on the Report 
Server.

Enable report threshold 
event notification

Select this option to enable events when reports 
contain values that exceed the threshold you set. 
Events are written to the Windows Event Log on 
the Web Service computer.
For more information about setting event 
thresholds for reports, see “Attributes” on 
page 113 and “Display > Threshold” on 
page 123. 

Include report 
configuration card

Select this option to include a configuration card 
with each deployed report.
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Setting Console Options
You can configure several Analysis Center Console options:

• Color scheme

• Display of cached reports

• Display of report date range under Report title

• Display of tooltips in the context tree

• Display of the Logon dialog box

• Message logging associated with the operation of the Console

To set the Console options:

1. Click Tools > Options. The Options dialog box is displayed.

2. From the list of User Options, select Console.
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3. Complete the fields as instructed below:

Field Description

Color Scheme Select a color scheme for the background color of the 
Console.

Show cached 
reports

Select to display the cached dataset for a report when 
you select the report. The location of the cached 
datasets is:
C:\Documents and Settings\<user>\Local 
Settings\Application 
Data\NetIQ\Analysis Center\ReportCache

Clear to always run the report for the most-recent 
dataset.
Click Delete Files to delete all cached datasets.

Show report date 
range selection

Select to display the date range of the report beneath 
the report title in the created report.

Show report context 
tree tooltips

Select to display tooltips for the report context tree 
control.
Clear to hide tooltips for the report context tree control.

Show Logon dialog Select to display the Logon dialog box when you start 
the Analysis Center Console.
You do not have to display the Logon dialog box if:

• You always connect to the same Web service.
• You use your current Windows credentials to 

connect to the Web service.
For more information, see “Starting the Console” on 
page 61.
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File Logging Level Select a logging level from the menu:
• Off (no messages are logged)
• Error (only error messages are logged)
• Warning (error and warning messages are 

logged)
• Info (error, warning, and informational messages 

are logged)
• Verbose (all messages are logged)

Messages are written to NetIQTrace.log (Typically, 
the default location is  C:\Documents and 
Settings\All Users\Application 
Data\NetIQLOG

Field Description
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4. Click OK.

Event Logging Level Select the logging level from the menu:
• Off (no messages are logged)
• Error (only error messages are logged)
• Warning (error and warning messages are 

logged)
• Info (error, warning, and informational messages 

are logged)
Messages are written to the Windows Event Log.

Data Warehouse 
Logging Level

Select the logging level from the menu:
• Off (no messages are logged)
• Error (only error messages are logged)
• Warning (error and warning messages are 

logged)
• Info (error, warning, and informational messages 

are logged)
• Verbose (all messages are logged)

Messages are written to the AC_Configuration 
database when tracing is enabled for the Web Service 
and the level of  trace messages is equal to or greater 
than the level specified here.
Tracing for the Web Service is set in the Web.config 
file. For more information, see “Enabling Tracing” on 
page 185.

Field Description
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Managing SQL Server Agent Jobs
When you select a Data Source in the Navigation pane, the list of associated SQL Server 
Agent job instances is displayed in the upper portion of the Results pane. When you 
select a job instance in the list, the job steps that make up the instance are listed in the 
lower portion of the Results pane.

You can right-click any job instance to issue the following commands:

• Start job (starts the SQL Server Agent job)

• Stop job (stops the SQL Server Agent job)

• Enable job (enables the SQL Server Agent job)

• Disable job (disables the SQL Server Agent job)

• Show Detail Log (displays details of how each step of the jobs was created)

If there is a problem with a job, you can use SQL Server Enterprise Manager to 
investigate the cause.

To view the history of a job in SQL Server Enterprise Manager:

1. Open SQL Server Enterprise Manager.

2. Expand the appropriate SQL Server.

3. Expand Management.

4. Expand SQL Server Agent.

5. Select Jobs.

6. Right-click the appropriate job and select View Job History.

7. Select Show step details.

8. Scroll through the list of steps to find the one on which the job failed and select 
that step.

9. Review the text in the Errors and/or messages field.
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Editing the Web.config File
The Web.config file is used to configure the Analysis Center Web Service. The default 
location for the file is:

Program Files\NetIQ\Analysis Center\WebService\Web.config

You can modify the configuration of the Web Service by editing different portions of 
Web.config.

Adding Users
By default, each time a user connects to the Web Service, Analysis Center first checks to 
see whether that user is identified in the AC_Configuration database as an Analysis 
Center user. 

If the connecting user is an Analysis Center user, authentication proceeds based upon 
the Analysis Center permissions assigned to that user. 

If the connecting user is not an Analysis Center user, Analysis Center looks at the local 
Windows user groups Administrators and Users. If the connecting user is a member of 
Administrators, then that user is added to the AC_Configuration database as an 
Analysis Center user with administrative permissions (full permissions for Analysis 
Center). If the connecting user is a member of Users, then that user is added to the 
AC_Configuration database as a non-administrative Analysis Center user.

The <appSettings> element allows you to enable or disable this process, and to specify 
a list of Analysis Center users with administrative permissions.

Using Web.config to add users to Analysis Center gives you a method of recreating 
users in the event someone deletes all users and groups from the Analysis Center 
Console.
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The <appSettings> element is near the beginning of Web.config:

<appSettings>

<!--Add following Entry to remove nt group check entirely, no 
automatic group additions-->

<!--<add key="NO NT GROUP CHECK" value="true" />-->

<!--When the following users connect, they are automatically added-
->

<!--<add key="AC Administrators" 
value="{localcomputer}\{account},{domain}\{account}" />-->

</appSettings>

Group checking is enabled by default. To disable this process, remove the comment tags 
from the following line:

<!--<add key="NO NT GROUP CHECK" value="true" />-->

so that it reads

<add key="NO NT GROUP CHECK" value="true" />

To add users with administrative permissions to Analysis Center:

1. Remove the comment tags from the following line:

<!--<add key="AC Administrators" 
value="{localcomputer}\{account},{domain}\{account}" />-->

so that it reads

<add key="AC Administrators" 
value="{localcomputer}\{account},{domain}\{account}" />

2. Replace {localcomputer}\{account},{domain}\{account} with the 
appropriate account information.

• Use the {localcomputer}\{account} format for accounts local to the Web 
Service computer.

• Use the {domain}\{account} format for domain accounts.

• Separate multiple accounts with commas and no spaces.
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Enabling Tracing
You can enable the logging of trace messages by editing the <switches> and 
<listeners> elements.

Find the <switches> element near the end of the file:

<switches>

<!--Trace Level  0=Off, 1=Error, 2=Warning, 3=Information, 
4=Verbose-->

<add name="NQLOGSQL" value="0" />

<add name="NQLOGEVENT" value="1" />

<add name="NQLOGFILE" value="1" />

</switches>

You can log trace messages in three places:

• The NQLOGSQL switch enables the logging of trace messages to the 
AC_Configuration database LogMessage table. You can open the LogMessage 
table using SQL Server Enterprise Manager.

• The NQLOGEVENT switch enables the logging of trace messages to the Windows 
Application Log. You can open the Application Log using the Windows Event 
Viewer.

• The NQLOGFILE switch enables the logging of trace messages to the 
NetIQTrace.LOG file. You can open NetIQTrace.LOG using a text editor like 
Notepad.

Note
Any given instance of the Web.config file may vary from the example used here, but 
you must make changes to the file exactly as illustrated.
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To set the level of logging to any destination, use the trace level values 0 - 4. For example, 
to log verbose messages to all destinations, edit the following lines as follows:

• <add name="NQLOGSQL" value="4" />

• <add name="NQLOGEVENT" value="4" />

• <add name="NQLOGFILE" value="4" />

After you edit the <switches> section, you then need to edit the <listeners> section, 
which is just below <switches>.

For each switch that you have enabled, you need to instantiate a corresponding listener. 
The SQL listener is instantiated by default. You need to explicitly instantiate the 
NQLOGEVENT and NQLOGFILE listeners. To instantiate those, add the following lines to 
the <listeners> element:

<add name="NQLOGEVENT" 
type="NetIQ.Diagnostics.NQEventLogListener,NQACSHARED2, 
Culture=neutral, PublicKeyToken=990b740647d733f3"/>

<add name="NQLOGFILE" 
type="NetIQ.Diagnostics.NQFileLogListener,NQACSHARED2, 
Culture=neutral, PublicKeyToken=990b740647d733f3"/>

Note
To successfully enable the NQLOGFILE switch and listener, the Web Service must be 
using an account that has sufficient permission to write to NetIQTrace.LOG.
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Changing Timeout Values
The timeout values for connections to the various Analysis Center databases are defined 
in the <Connections> element. If you are running reports that return large datasets, 
the time required for the queries to fully run may exceed those connection timeout 
settings, causing the queries to abort. You can increase the timeout setting by editing the 
value for the TimeOut attribute for each <Connection> element. You should also edit 
the connection timeout value for the Web Service Web site. For more information, see 
“Adjusting the Connection Timeout for the Web Service Web Site” on page 188.

<Connections>

<Connection Name="ACOLAP" Server="localhost" OLAPCatalog="AC_OLAP" 
ConnectionType="OLAP" TimeOut="3600" />

<Connection Name="AC" Server="localhost" Database="AC_Warehouse" 
ConnectionType="SQL" TimeOut="3600" />

<Connection Name="AC_Config" Server="localhost" 
Database="AC_Configuration" ConnectionType="SQL" TimeOut="3600" />

</Connections>

You can also increase the value for the executionTimeout attribute of the 
<httpRuntime> element, which governs the length of time a request is allowed to run 
before being automatically shut down by ASP.NET.

Find the <httpRuntime> element about two-thirds of the way through the Web.config 
file:

<httpRuntime executionTimeout="3600"

maxRequestLength="4096"

useFullyQualifiedRedirectUrl="false"

minFreeThreads="8"

minLocalRequestFreeThreads="4"

appRequestQueueLimit="100" />

Set the executionTimout value to match the TimeOut values you set for the 
<Connection> elements above.

Note
If you continue to have report failures due to connection errors, try increasing these 
timeout values.
Chapter 12 • Performing Administrative Tasks     187



Adjusting the Connection Timeout for the Web 
Service Web Site

In addition to adjusting timeout values in Web.config to address problems with the 
time required for the report queries to fully run, you should also adjust the connection 
timeout value for the Web site that hosts the Web Service virtual directory. For more 
information, see “Changing Timeout Values” on page 187.

To adjust the connection timeout value:

1. On the computer where you have installed the Web Service, click Start > Programs 
> Administrative Tools > Internet Services Manager.

2. Expand the appropriate IIS Server.

3. Right-click the Web site hosting the Web Service virtual directory and select 
Properties.

4. Enter an appropriate value in the Connection Timeout: ____ seconds field.

The value you use depends entirely on your Analysis Center environment (for 
example, the system resources of each Analysis Center computer and the speed of 
your network) and the amount of data being returned by your report queries. If you 
continue to have report failures due to connection errors, try increasing this value.

5. Click OK.
188     Analysis Center User Guide 



Chapter 13

Customizing Reports
This chapter provides information about customizing the Analysis Center reports.

Customizing Reports with Analysis Center 
Console

The simplest way to create a custom version of a report is to open the report in the 
Console, and then set the context and properties so that your information is 
presented in the appropriate format. Once you have configured the report exactly as 
you like it, you can then save it under a new name.

For more information about setting the context and properties for a report, and 
saving different versions of a report, see “Generating Live Reports” on page 91.

Editing the Report XML
You can also customize a report by editing its XML file. The XML files for Analysis 
Center reports are located in the following folders on the Analysis Center Console 
computer:

• \Analysis Center\Config\Reports\AC20 (reports that are displayed under 
the Reports folder in the Navigation pane)

• \Analysis Center\Config\Reports\Templates (report templates that are 
displayed under the Templates folder in the Navigation pane)
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The following example describes the XML tags and how to modify them for the CPU 
Utilization By Server report.

The report file name is: Performance.AverageCPUUtilizationByServer.XML 

You can open the file using Internet Explorer or any text editor. 

XML Tags
The CPU Utilization By Server report has the following XML tags:

<REPORTSET FOLDER="Performance"> 
The FOLDER attribute determines the folder location of the report under the 
Reports folder. In this case, it is located under Reports\Performance.

<VIEW>Master</VIEW> determines which view is selected by default for the Group 
context. In this case, the Master view is selected. <VIEW/> is a child folder of the 
<REPORTSET/>

<NQREPORT ID="CPU Utilization by Server" Title="CPU Utilization by 
Server" Description="Average CPU Utilization by Server">

• <NQREPORT/> folder is a child folder of the <REPORTSET/>.

• The ID attribute is a unique string identifier for a report within Analysis Center. If 
you make changes to the report and save it with a different name, you must edit this 
attribute to ensure that it is unique.

• The Title attribute is the name of a report as it is displayed in the Navigation pane 
and Results pane.

• The Description attribute is a description of the report that is displayed under the 
title of the report in the Results pane.

<PARAMETERS /> 
Determines which parameters are available for a report. In this case, there are 
none. Analysis Center uses parameters for defining N for Top N ... reports.  
The Console displays parameters in the Properties tab of the Tasks pane.
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<CONTEXT TYPE="NetIQ.ACLib.Metrics.MetricContext,NQACLib" ID="1" 
IsAggregate="false" Title="Metric:CPU Utilization" 
MetricFilter="Application:NT,Unix;
Description1:%Performance Data;Description2:%Processor 
Utilization%;" />

<CONTEXT TYPE="NetIQ.ACLib.Times.TimeContext,NQACLib" ID="1" 
IsAggregate="true" IsMultiple="true" TimeRangeName="Last 28 Days" 
Interval="Day" />

The CONTEXT tags determine which contexts are available for a report, in this case the 
Metric and Time contexts also include the Group context, which is not shown here.

• The TYPE attribute identifies the context control, in this case, the MetricContext 
and TimeContext controls.

• The ID attribute identifies the instance of the context control. In most cases the 
value for this attribute is 1 because there is usually only one instance of a context 
control for a report. There can be multiple instances of a control, for example, 
when reports contain two time contexts. If there is more than one instance of a 
control, the second control would have an ID value of 2, and so on.

• The IsAggregate attribute determines whether data is aggregated in the time 
context. For example, the time range selected is Last 28 Days, and the data is 
aggregated by day.

• The IsMultiple attribute determines whether you can select multiple items within 
the context. For example, in the Time context, you can select a time range and the 
interval at which the data is aggregated.

The Metric context has some additional attributes that identify which data you can 
select for the report.

• The Title attribute sets a title for the context, which the Console displays in the 
title bar for the context control. The title is only informational, and does not 
determine which data can be selected. In the case of the Metric context, the title is 
Metric:CPU Utilization.

• The MetricFilter attribute determines which data is available for selection. The 
values for this attribute identify the cube dimensions from which you can select.

The Application value determines which categories of AppManager Knowledge 
Script data you can select from the Application dimension. For example, Exchange, 
NT, or SQL.
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The Description1 value determines which type of data within the application you 
can select from the Metric dimension. For example, performance or event data.

The Description2 value further filters the type of data you can select. For 
example, within performance data, you can limit the selection to Processor 
Utilization data.

<QUERY TYPE="NetIQ.ACLib.ACQUERY,NQACLib">

<CONTEXTS>

<CONTEXT TYPE="NetIQ.ACLib.Cubes.CubeContext,NQACLib"

ID="1" CubeName="vAMGeneric" />

</CONTEXTS>

<Template> WITH {TimeContext[1].MDX} {MetricContext[1].MDX} 
{GroupContext[1].MDX} MEMBER [Measures].[Average Utilization] as 
'([Measures].[MetricSum])/ ([Measures].[MetricCount])' SELECT { 
{GroupContext[1].Name} } on Rows, {{MetricContext[1].Name} } on 
COLUMNS FROM [{CubeContext.Name}{TimeContext[1].UTC}] WHERE 
({MetricContext[1].AppFilter},[Measures].[Average 
Utilization],{TimeContext[1].Name}, {TimeContext[1].filter} ) </
Template>

The QUERY tag defines the query run by the report.

• The TYPE attribute determines the type of query. In general, these reports run an 
MDX query (ACQUERY).

• Within the QUERY tag, the CONTEXTS tag determines which contexts identify the 
source of data. Each individual CONTEXT tag identifies a single context and context 
control.

The TYPE attribute for the CONTEXT tag identifies the context control, in this case, 
the CubeContext control.

The ID attribute identifies the instance of the CubeContext control. In most cases 
the value for this attribute is 1 because there is usually only one instance of this 
control for a report

The CubeName attribute identifies the cube that is queried.

• Within the QUERY tag, the TEMPLATE tag identifies the query template used for the 
report.
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Variables in the query template are identified by braces (for example, 
{TimeContext[1].MDX}). The values for those variables are determined by the 
context settings you make in the Console.

Modifying the XML
By modifying the report XML, you can, for example, take the CPU Utilization by Server 
report, which uses data collected by the NT_CpuLoaded Knowledge Script, and create a 
report about the CPU utilization of SQL Server processes based on data collected by the 
SQL_CPUUtil Knowledge Script. 

To modify the XML:

1. Change the value for the VIEW tag to <VIEW>SQL</VIEW>

2. Change the first three attributes of the <NQREPORT> tag as follows:

• ID="CPU Utilization by SQL Server Services". The ID value must be 
unique for Analysis Center reports.

• Title="CPU Utilization by SQL Server Services"

• Description="Average CPU Utilization by SQL Server Processes"

3. For the metric context, make the following changes:

• Title="Metric:SQL CPU Utilization"

• MetricFilter="Application:SQL;Description1%Performance 

Data;Description2%Process CPU Utilization%;"

4. In the Analysis Center\Config\Reports\AC20 folder, save the file under the 
name Performance.AverageCPUUtilizationBySQLProcesses.XML.

Note
You can find the MetricFilter Description values by using Analysis 
Manager to open the AC_OLAP database, and view the data in the vAMGeneric 
cube. Under Metric, expand the All Metrics, and then AM NT Performance 
Data; you will see % Process CPU Utilization, which contains the data 
streams collected by the SQL_CPUUtil Knowledge Script.
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5. Use XMLCheckIn.exe to check the file in to the AC_Configuration database. 
XMLCheckIn.exe is located in \Analysis Center\bin.

Use the following syntax: 
xmlcheckin <path to file>\<file name>

The report is listed under Reports\Performance in the Navigation pane of the 
Console.

Using Report Designer to Edit RDL Files
Another option you have for customizing reports is to use Report Designer to edit the 
Report Definition Language (RDL) files for reports you have deployed to SQL 
Reporting Services. A thorough working knowledge of Report Designer is necessary for 
making this sort of modification to a report. For more information about using Report 
Designer, see the Reporting Services Books Online and Microsoft Visual Studio .NET 
Documentation.
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Appendix A

Troubleshooting
This appendix includes solutions for some problems that you may encounter. If you 
see any of the following error messages, try the accompanying solutions to rectify the 
underlying problems.

Database open error
The Remote Registry service should run on all Analysis Center computers. 
Otherwise you can get this error message:

###--> ERROR: » - Error: -2147467259
Description: Cannot open database requested in login 
'AC_Configuration'. Login fails.
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Invalid URL, Server unavailable
You may encounter this message when attempting to log on to the Console when the 
Web Service is installed on a computer running Windows 2003. One known cause of 
this problem is a change in the password for the domain account used for the Analysis 
Center Application Pool identity, which prevents the Web Service from connecting to 
the Data Warehouse. If the password for the domain account changes, it must be 
updated in the properties for ACAppPool.

To update the Application Pool identity:

1. On the Windows 2003 computer that is hosting the Web Service, click Start > 
Programs > Administrative Tools > Internet Information Services (IIS) Manager.

2. Expand Application Pools.

3. Right-click ACAppPool and select Properties.

4. Click the Identity tab.

5. Verify that the Configurable option is selected and that the correct domain account 
is displayed in the User name field.

6. In the Password field, enter the correct password for the domain account.

The underlying connection was closed: Unable to connect to the 
remote server

You will see this error message when connections are lost between Analysis Center 
components, for example, if a physical network connection is lost due to, perhaps, a 
down router or switch, or the computer being unplugged from the network, or if the IIS 
server hosting the Web Service is not running because, for example, one of the 
component IIS services is not running, or the computer hosting the IIS server is not 
running.
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Reporting Services error “An error has occurred during report 
processing ...”

The following error message is displayed in Report Manager when the connections 
required to process a report cannot be made SQL Reporting Services to Data Extension 
to Web Service to Data Warehouse: 

“An error has occurred during report processing ... Cannot create a 
connection to data source ... The request failed with HTTP status 401: 
Access Denied.”

This error occurs when:

• You have selected Windows NT Integrated Security as the Report Server 
Credentials when deploying a report.

• Analysis Center components are distributed among a number of computers.

Under these circumstances, you encounter the Windows “double-hop” issue in 
which Windows security credentials are not recognized for more than one 
connection. Credentials are recognized from Server A to Server B, but not from 
Server B to Server C.

You can overcome this problem by using the Select shared Report Server Data Source 
option for Report Server Credentials when deploying a report, and selecting the 
Credentials stored securely in the report server property for either the shared data 
source or the individual deployed report.

For more information about deploying a report, see “Deploying a Report” on page 157.

To set the Credentials stored securely in the report server property for a data source, 
use Report Manager to edit the data source properties:

1. Select the data source in Report Manager. 

2. In the Connect Using section, select the Credentials stored securely in the report 
server option.

3. Enter the User name (<domain\user>) and Password.
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Do not select either of the following options: Use as Windows credentials or 
Impersonate the authenticated user. The Analysis Center Web Service handles 
authentication of the user to the Data Warehouse.

4. Click Apply.

To set the Credentials stored securely in the report server property for a deployed 
report:

1. Open the Properties page for the report in Report Manager.

2. Click the Data Sources link on the Properties page.

3. Select A custom data source.

4. In the Connect Using section, select Credentials stored securely in the report 
server.

5. Enter the user name (<domain\user>) and password.

Do not select either of the two options Use as Windows credentials or 
Impersonate the authenticated user. The Analysis Center Web Service handles 
authentication of the user to the Data Warehouse.

6. Click Apply.

OLAP processing job fails: Inaccessible Data Mart
If you add a Data Source for which the Data Mart does not exist or is inaccessible, you 
may run into problems when you try to delete the Data Source. In this scenario, the first 
run of the OLAP processing job fails after you delete the Data Source.

This failure causes no real problem in Analysis Center. The second run of the OLAP 
processing job succeeds. 

To avoid the OLAP job failure, when deleting a Data Source that has an inaccessible 
Data Mart, do not delete the Data Mart database. The Data Mart may be inaccessible 
because the wrong authentication credentials were provided when creating the Data 
Source.

When prompted to remove the Data Mart database, select No.
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